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Icons 
 

Icon Meaning 

 
Caution 

 
Example 

 
Note 

 
Recommendation 

 
Syntax 

 

 

Typographic Conventions 
 

Type Style Description 

Example text Words or characters that appear on the screen. These include field 
names, screen titles, pushbuttons as well as menu names, paths and 
options. 

Cross-references to other documentation 
Example text Emphasized words or phrases in body text, titles of graphics and tables

EXAMPLE TEXT Names of elements in the system. These include report names, 
program names, transaction codes, table names, and individual key 
words of a programming language, when surrounded by body text, for 
example, SELECT and INCLUDE. 

Example text Screen output. This includes file and directory names and their paths, 
messages, names of variables and parameters, source code as well as 
names of installation, upgrade and database tools. 

Example text Exact user entry. These are words or characters that you enter in the 
system exactly as they appear in the documentation. 

<Example text> Variable user entry. Pointed brackets indicate that you replace these 
words and characters with appropriate entries. 

EXAMPLE TEXT Keys on the keyboard, for example, function keys (such as F2) or the 
ENTER key 
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  Product Cost Controlling (CO-PC) 

Product Cost Controlling (CO-PC) 
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Analyzing the Multilevel Price Determination [Page 114] 

Easy Cost Planning and Execution Services for an IT Project [Page 124] 
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Product Cost Planning, Costing Run, Primary Cost Component Split 

Product Cost Planning, Costing Run, Primary Cost 
Component Split 
Purpose 
Product Cost Planning is used to plan costs and to price materials. It determines the cost of 
goods manufactured (COGM) and cost of sales (COS) for each product unit. 

Material cost estimates can be created at various times during a fiscal year. 

• At the start of a fiscal year or accounting period 

• During the fiscal year 

• Before preparing the financial statements 

The purpose of the costing varies according to the time at which it is performed. The standard 
system contains costing variants: 

• for Standard Cost Estimates 

• for Modified Standard Cost Estimates 

• for Actual Costing 

The IDES System contains additional costing variants: 

• for inventory costing 

• cost estimates that also reflect sales and administration costs 

• for standard cost estimates, the costing variant DPC1 

• for modified standard cost estimates, the costing variant DPC2 

• for current cost estimates, the costing variant DPC3 

The following process flow shows how multiple materials can be costed in a single costing run. 

Process Flow 
You can find the data for this process under  [Page 9]. 

1. Checking Material Master Records [Page 10] 

2. Checking the Bill of Materials [Page 12] 

3. Checking Routings [Page 13] 

4. Processing the Costing Run [Page 14] 

 
 

8  April 2001 



 SAP AG Product Cost Controlling (CO-PC) 

  Data Used During This Process 

Data Used During This Process 
Field Data 

Material P-100 

Company code 1000 

Plant 1000 

Costing variant ZPC1 
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Checking the Material Master Record 

Checking the Material Master Record 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Material Master → Material → 
Display → Display Current 

Transaction Code MM03 

2. Enter the following data: 

Field Data 

Material P-100 

3. Choose Select view(s). 

4. In the Select View(s) dialog box, enter the following data: 

Field Data 

MRP 2 Select 

Accounting 1 Select 

Costing 1 Select 

5. Choose . 

6. In the Organizational Levels dialog box, enter the following data: 

Field Data 

Plant 1000 

Org. levels/profiles only on request Select 

7. Choose . 

On the Display Material P-100 (Finished Product) screen, the MRP 2 tab page appears. 

8. Choose . 

9. On the Accounting 1 tab page, enter the following data: 

Field Data 

Valuation class 7920 

Price control S (for standard price) 

10. Choose the Costing 1 tab page. 

11. Check the following entries: 

Field Data 

With quantity structure Select 

Material origin Select 

Overhead group SAP10 
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  Checking the Material Master Record 

12. Choose . 

13. In the Last data screen reached dialog box, choose Yes. 

14. Choose  until the overview tree appears. 
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Checking the Bill of Materials 

Checking the Bill of Materials 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Master Data → Bills of Material → Bill of 
Material → Material BOM → Display 

Transaction Code CS03 

2. Enter the following data: 

Field Data 

Material P-100 

Plant 1000 

BOM Usage 1 

3. Choose . 

4. On the Display Material BOM: General Item Overview screen, choose  Header. 

5. In the Extras: Header Information dialog box, enter the following data: 

Field Data 

BOM Usage 1 

6. Choose Close. 

7. Choose . 

8. Choose . 

9. Select the Status/Longtext tab page. 

10. Choose  to check up to the last item that Costing relevancy has been selected for all items 
of category L or R. 

11. Choose  until the overview tree appears. 

12  April 2001 



 SAP AG Product Cost Controlling (CO-PC) 

  Checking the Routing 

Checking the Routing 
1. Call up the transaction as follows: 

Menu Path From the Master Data node, choose Routings → Routings → Standard 
Routings → Display 

Transaction Code CA03 

2. Enter the following data: 

Field Data 

Material P-100 

Plant 1000 

3. Choose . 

4. Choose . 

5. Check the following entry: 

Field Data 

Status 4 

6. Choose  Operations. 

7. Choose . 

8. Choose Details → Operation. 

9. In the Display Routing: Operation Details screen check in the General data fields using the 
 (Next operation) function whether the indicator Costing relevancy has been set for all 

operations until you have reached the last operation. 

10. Choose  until the overview tree appears. 
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Processing the Costing Run 

Processing the Costing Run 
Use 
You process a costing run through the flow steps Create costing run, Selection of materials, 
Structure explosion, Costing, Analysis, Marking and Release. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Product Cost 
Planning → Material Costing → Edit Costing Run  

Transaction Code CK40N 

2. Choose . 

3. In the Create Costing Run screen, enter the following data: 

Field Data 

Costing run, 1. field Name of the costing run (user-defined) 

Costing run, 2. field Name of the costing run (user-defined) 

Costing run date Today`s date 

Costing variant ZPC1 

Costing version 01 

Company code 1000 

4. Choose  and . 

5. Check the following entries in the Dates tab page and change them if necessary: 

Field Data 

Costing date from Today`s date 

Costing date to Last day of the current fiscal year 

Qty structure date Today`s date 

Valuation date Today`s date 

6. Choose  and . 

7. In the Create cost estimate section choose Selection → . 

8. Enter the following data: 

Field Data 

Material P-100 

Plant 1000 

Background processing Deselect 
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  Processing the Costing Run 

9. Choose . 

10. Choose .  

11. In the Create cost estimate section choose Selection → . 

12. Choose .  

A green traffic light appears in the Selection line under Status. One material has been 
selected. This is quite correct. 

13. In the Create cost estimate section choose Structure Explosion → . 

14. Enter the following data: 

Field Data 

Background processing Deselect 

15. Choose . 

16. Choose . 

17. In the Create cost estimate section choose Structure Explosion → . 

18. Choose . 

A green traffic light appears in the Structure Explosion line under Status. 20 materials 
have been determined, none of which contains errors. 

19. In the Create cost estimate section choose Costing → . 

20. Enter the following data: 

Field Data 

Background processing Deselect 

21. Choose . 

22. Choose . 

23. In the Create cost estimate section choose Costing → .  

A green traffic light appears in the Costing line under Status. 20 materials are costed, 
none of which contains errors. All of the related costings are carried out. 

24. In the Costing results section choose . 

25. Choose Materials Overview. 

26. Select the line for Material P-100, then choose  → Multilevel BOM. 

You will see the costing structure. 

27. Choose . 

28. Select the line for material 100-100 and choose  → Cost Comps. 

29. Choose Settings → Type of Cost Component Split. 

30. In the Type of Cost Component Split dialog box select Auxiliary cost component split and 
choose . 
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Processing the Costing Run 

The costs of goods manufactured are now displayed in the primary cost component split. 

31. Choose . 

 
Allow Marking 

Marking can only be allowed once in a given period. Providing no release has yet 
occurred you can reset the marking allowance. However, you should note this 
cancels all marked prices. 

If marking is not yet allowed (locked padlock symbol) continue with step 36. 

If marking is already allowed (the padlock looks like this ), reset it as set out 
below: 

32. In the section Create cost estimate choose Marking → . 

33. Select the line for company code 1000. 

34. Choose . 

35. Choose . 

36. In the section Create cost estimate choose Marking → . 

37. Select the first line for company code 1000 by double-clicking. 

38. In the Permitted standard cost estimate variant dialog box, enter the following data: 

Field Data 

Costing variant ZPC1 

39. Choose . 

The system confirms that the marking allowance has been issued. 

You can repeat the marking as often as required, until the standard costing has been 
released. 

40. Choose . 

41. In the Create cost estimate section choose Marking → . 

42. In the Price Update: Mark Standard Price screen, enter the following data: 

Field Data 

Background processing Deselect 

Test run Deselect 

43. Choose . 

44. Choose . 

45. In the section Create cost estimate section choose Marking → .  

A green traffic light appears in the Marking line under Status. 20 materials have been 
marked, none of which contains errors. 
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  Processing the Costing Run 

 
The standard cost estimate of a material can only be released once in a given 
period. 

46. In the Create cost estimate section choose Release → . 

47. Enter the following data: 

Field Data 

Test run Select 

Background processing Deselect 

By selecting Test run, you ensure that the system only simulates the release of the 
standard cost estimate. If you do not select this field, the costed price is entered in the 
material master under the Costing 2 view. 

48. Choose . 

49. Choose . 

50. In the Create cost estimate section choose Release → . 

 
The procedure described in this scenario differs from the standard in that the 
marking and the release are executed in the same period. 

To ensure costing accuracy, the standard system assumes that the Costing date 
from is the first day of the next period. This means that the marking is made in the 
current period, and the release in the next period. 

51. Choose  until the overview tree appears. 
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Product Cost Planning with Multi-level Unit Costing 

Product Cost Planning with Multi-level Unit Costing 
Purpose 
The multi-level unit costing is a costing method you can use to carry out the following work 
centrally: 

• Maintain reference and simulation costing 

• Maintain product costing without quantity structure 

• Copy product costing with quantity structure to unit costing 

In the following process you use a multi-level unit costing to change both a product costing with 
quantity structure and a reference and simulation costing. 

Process Flow 
You can find the data for this process under  [Ext.]. 

1. Creating a Worklist [Page 19] 

2. Displaying a Product Costing with Quantity Structure [Page 21] 

3. Copying a Product Costing with Quantity Structure [Page 22] 

4. Processing the Base Planning Object [Page 24] 

5. Cost Analysis [Page 25] 
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  Creating the Worklist 

Creating the Worklist 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Product Cost 
Planning → Reference and Simulation Costing → Edit Base Planning 
Object - Multi-level 

Transaction Code CKUC 

2. In the Set controlling area dialog box, enter the following data: 

Field Data 

Controlling area 1000 

3. Choose . 

 
You should also refer to the overview screen for the multi-level unit costing [Ext.] 

4. Position your cursor on the screen edge (in the middle of the screen) then holding down the 
left mouse button drag the left screen as far as the Resource column. 

5. Choose Worklists on. 

On the right side of the screen you can see 3 tab pages that display automatically 
generated worklists. The left tab page contains your user name under which you initially 
create a personal worklist. 

6. Select Material cost estimate in the worklist and using the right mouse button call up a 
window. 

7. Choose Select material cost estimate. 

8. In the Selection of material cost estimates dialog box, enter the following data: 

Field Data 

Material number P-100 

With quantity structure Select 

Without quantity structure Deselect 

9. Choose  twice. 

10. In the dialog box select the line with the following data: Material P-100, Plant 1000, Costing 
variant PPC1, Status KA and Valid from 1.11.1999. 

11. Choose . 

12. Select Base planning object in the worklist and choose Select base planning object using the 
right mouse button as described above. 

13. In the Selection: base planning objects dialog box, enter the following data: 

Field Data 

Base planning object P-100 
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Creating the Worklist 

14. Choose . 

A base planning object already created for pump GG Standard 150-200, which the IDES 
company plans to introduce shortly is entered in your worklist. 

You then create the internal activity Machine hours in the worklist. 

15. Select Internal Activity in the worklist and choose Select internal activity using the right 
mouse button. 

16. In the dialog box (1), Restrictions tab page, enter the following data: 

Field Data 

Cost center 4220 

Activity type 1420 

17. Choose . 

18. Position your cursor on the line 1999 Pumps Production machine hours, then choose . 

The activity type 1420 machine hours which is provided by the cost center 4220 
production pumps and contains a price is automatically placed in your worklist. 

19. Select Process in the worklist and choose Select process using the right mouse button. 

20. Choose the Business process tab page. 

21. Enter the following data: 

Field Data 

Business process 300900 

Language key EN 

22. Choose . 

23. Select the line having the business process 300900, then choose . 

The process Work scheduling is likewise placed in your worklist. 

24. Choose  to save the worklist. 

The system displays the message Worklist was saved. 

Consequently the worklist is retained for you to use for future processing. 

25. Remain on this screen. 
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  Displaying a Product Costing with Quantity Structure 

Displaying a Product Costing with Quantity Structure 
1. Select the line  Pump PRECISION 100 in the worklist under Material cost estimate and 

drag this by keeping the left mouse button depressed across to the Costing structure on the 
left of the screen. 

The Transfer/Copy Material Cost Estimate dialog box appears. 

2. To display the cost estimate, select Transfer cost estimate as original. 

However, it is now no longer possible for you to change or adjust the cost estimate. The 
product cost planning selected is inserted in the relevant costing structure. 

3. Choose  Copy. 

4. In the costing structure double-click on  Pump PRECISION 100. 

You see detailed information on the selected cost estimate in the upper right-hand side 
of the screen. 

The History tab page details the user who created the cost estimate, and the remaining 
tab pages contain additional detailed information. 

5. To display the itemization or cost components choose  or  respectively. 

6. You have the option in the left-hand side of the screen of choosing  → Show all items. 

All items for costing structure Pump PRECISION 100 are now displayed. 

7. In the menu bar choose . 

In the Symbol legends dialog box you can ascertain the meaning of the respective icons 
or items. 

8. Choose . 

9. In the costing structure under  Pump PRECISION 100 double-click on  Spiral casing 
GG. 

You receive detailed information on the spiral casing. 

On checking the cost estimate for the Pump PRECISION 100 you establish that several 
items are missing or outdated. 

To change this cost estimate, next transfer the product costing with quantity structure as 
a copy from the worklist to the costing structure. 

10. Remain on this screen. 
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Copying a Product Costing with Quantity Structure 

Copying a Product Costing with Quantity Structure 
11. Choose Worklists on if required. 

12. Select the line  Pump PRECISION 100 in the worklist under Material cost estimate and 
drag this by keeping the left mouse button depressed across to the Costing structure on the 
left of the screen. 

The Transfer/Copy Material Cost Estimate dialog box appears. 

13. Enter the following data: 

Field Data 

Copy cost est. acc. to Select 

Costing variant SIM1 

Costing version 10 

14. Choose  Copy. 

 
If you want to repeat the example several times choose a different version number. 

15. On the left side of the screen double-click on  Pump PRECISION 100. 

All items for costing structure Pump PRECISION 100 are now displayed. 

16. Choose . 

Through the copy the material cost estimate with quantity structure in the worklist (  
Automatic cost estimate) has become a unit costing (  Unit cost estimate). 

As the unit cost estimate relates to a particular material, it is also designated product cost 
planning without quantity structure. 

17. Choose . 

18. Choose  Spiral casing GG by double-clicking in the costing structure of  Pump 
PRECISION 100. 

In the basic view you can now see the entire work flow and the required material usage 
for the production of 100 slugs for spiral cases. 

You now implement the process  Work scheduling before the production process  
Slug for spiral casing and change the price of the raw material needed to manufacture 
the slug, as you have in the meantime found a more competitive supplier. 

You also need to implement the process step Work schedule after the third item. 

19. Select the line with item 4, and choose  (Insert line). 

20. Deselect the line with item 5 and select again the line with item 4. 

21. Choose . 

22. In the dialog box, enter the following data: 
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  Copying a Product Costing with Quantity Structure 

Field Data 

Item category process (manual) 

Business process 300900 

23. Choose . 

In the costing items basic view the work scheduling process is automatically set in item 4 

24. Enter a 3 in the Quantity column for this item and choose Confirm. 

You would now like to incorporate the cheaper material from the new supplier in the cost 
estimate. 

25. Select field M (Material) in line 5 in the column Category, then choose the Possible entries 
button. 

In the Item category dialog box, you now have the option of entering a variety of items. In 
addition to an existing base planning object you can for example also choose an internal 
activity or variable item for the free entry of a costing item. 

26. Select V, then choose . 

27. In the same line enter the following data: 

Field Data 

Price-total 9,50 

28. Choose  Transfer. 

The items are automatically transferred to the costing structure on the left-hand side of 
the screen. In addition these items are to be revaluated. 

29. To do this select the line  Pump PRECISION 100 in the costing structure and using the 
right mouse button select Revaluate substructure. 

You now have a new unit costing with the costing variants SIM1 and costing version 10. 
Both of your changes namely the inclusion of the process work scheduling the cheaper 
material have been included. 

30. Close the costing structure  Pump PRECISION 100. 

In the following you use a base planning object you have already created as the basis for 
further calculations. 

31. Remain on this screen. 
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Processing the Base Planning Object 

Processing the Base Planning Object 
1. In the worklist under Base planning object select the line  Pump GG Standard 150-200 

and by keeping the left mouse button down drag this across to the Costing structure on the 
left hand side of the screen. 

2. Select  Pump GG Standard 150-200 and using the right mouse button choose Change 
cost estimate. 

You see the Costing items basic view for the pump on the upper right hand side of the 
screen. You would like to insert the internal activity machine hours after the 7th item. 

3. Select line 8, then choose . 

4. Double-click on Machine hours in the worklist. 

5. Double-click on the field Resource in line 8. 

6. Enter a 3 in the Quantity column for this item. 

7. Choose  Transfer. 

The new structure is adjusted and the cost estimate temporarily saved. 

8. Select the line  Pump PRECISION 100 in the costing structure and using the right mouse 
button select Revaluate substructure. 

The base planning object is revaluated. 

In the following the related cost component split or cost structure is discussed. 

9. Remain on this screen. 
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  Cost Analysis 

Cost Analysis 
1. In the worklist under Material cost estimate double-click on  Pump PRECISION 100. 

2. In the Costs tab page choose . 

In the upper half of the screen the cost component split of the unit costing of material P-
100 that you have already carried out is displayed. 

3. On the left-hand side of the screen choose  → Select layout → 1 SAP02. 

You now receive the structure with allocation, material, production, overhead status, 
process costs and so on. You can likewise display the cost distribution lower 
level/level/total. 

4. Choose  until the overview tree appears. 

5. In the Saving edited cost estimates dialog box, choose Yes. 
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Data Used During This Process 

Data Used During This Process 
Field Europe North America 

Company code 1000 3000 

Period Current period Current period 

Fiscal year Current year Current year 

Cost element 474100 474100 

Document type KR KR 

Vendor 1000 1000 

Function area 0100 0100 

Function area 0300 0300 

Function area 0400 0400 

Function area 0500 0500 

Substitution rule ID-COGS NA-COGS 

Ledger 0F 0F 

Report Writer library 0F1 0F1 

Report Writer library 0F-GUV1 0F-GUV1 
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Product Cost by Order 
Purpose 
During order-related production, Cost Object Controlling can provide you with information about a 
production order that settles its costs to inventory. 

Process Flow 
You can find the data for this process under  [Page 28] 

1. Opening a Production Order [Page 29] 

2. Displaying the Cost Analysis of a Production Order [Page 30] 

3. Processing the Goods Issue for the Production Order [Page 31] 

4. Confirming the Production Order [Page 32] 

5. Calculating Actual Overhead for a Production Order [Page 33] 

6. Calculating WIP [Page 34] 

7. Calculating and Explaining Variances [Page 35] 

8. Settling the Production Order [Page 36] 

9. Data Collection for the Information System [Page 37] 

10. The Information System for Order-Related Production [Page 39] 
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Data Used During This Process 
Field Data Description 

Plant 1000 Plant of the model firm 

Material P-100 Pump GG Standard 150-200 

Controlling area 1000 Example – controlling area. 
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Opening the Production Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Production Control → Order → Create → With 
Material 

Transaction Code CO01 

2. Enter the following data: 

Field Data 

Material P-100 

Production plant 1000 

Order type PP01 

3. Choose . 

4. Enter the following data: 

Field Data 

Total quantity 10 

Dates/Start Today`s date 

Scheduling/Type Forwards 

5. Choose . 

6. Choose . 

The release is executed. 

7. Choose . 

8. Make a note of the production order number. 

9. Choose  until the overview tree appears. 
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Displaying the Cost Analysis of a Production Order 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Cost Object 
Controlling → Product Cost by Order → Information System → Reports 
for Product Cost by Order → Detailed Reports → For Orders 

Transaction Code KKBC_ORD 

 
If the Set Controlling Area dialog box appears, enter the following data: 

Field Data 

Controlling area 1000 

2. Choose . 

3. Enter the following data: 

Field Data 

Order Your production order number (predefined) 

4. Choose . 

5. Select layout 1SAP02. 

6. Choose . 

The Cost Development screen appears. 

 
If you want to display different data, select a different layout. 

7. Choose  until the overview tree appears. 

 
 

30  April 2001 



 SAP AG Product Cost Controlling (CO-PC) 

  Processing the Goods Issue for the Production Order 

Processing the Goods Issue for the Production Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Production Control → Goods Movements → 
Goods Issue 

Transaction Code MB1A 

2. Choose To order... 

3. In the Reference: Order dialog box, enter the number of your production order, then choose 
. 

4. On the Enter Goods Issue: Selection Screen, select all materials that are to be issued for this 
order. To ensure that a variance is generated by the goods issue posting, enter a withdrawal 
of 11 pieces for material component 100-200 instead of the planned 10 pieces. 

5. Choose Adopt + Details. 

6. On the Enter Goods Issue: New Item XXXX  screen, choose  for each of the selected 
materials 

 
Confirm any warnings that may appear. 

If the system displays any error messages, check the quantity of the material that 
you have in stock and change the quantity to be withdrawn accordingly.  

 
To analyze the costs of this production order, see Displaying the Cost Analysis of the 
Production Order [Page 30] 

7. Choose  until the overview tree appears. 
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Confirming the Production Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Production control → Confirmation → Enter → 
For order 

Transaction Code CO15 

2. Enter the following data: 

Field Data 

Order Number of your production order 

3. Choose . 

4. On the Confirmation of Production Order Create: Actual data screen, select Final conf. 

5. Choose . 

The confirmation is being saved. 

6. Choose  until the overview tree appears. 
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Calculating Actual Overhead for a Production Order 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Cost Object 
Controlling → Product Cost by Order → Period-End Closing → Single 
Functions → Overhead → Individual Processing 

Transaction Code KGI2 

2. Enter the following data: 

Field Data 

Order Number of your production order 

Period Current period 

Fiscal year Current year 

Test run Deselect 

3. Choose . 

You receive the basic list for the ACTUAL overhead calculation. 

 
To analyze the costs of this production order, see Displaying the Cost Analysis of the 
Production Order [Page 30] 

4. Choose  until the overview tree appears. 
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Calculating WIP 
Use 
Before you can determine the variances, you need to establish how much work in process there 
still is. Hence you first calculate the work in process (WIP). 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Cost Object 
Controlling → Product Cost by Order → Period-End Closing → Single 
Functions → Work in Process → Calculate 

Transaction Code KKAX 

2. Enter the following data: 

Field Data 

Order Number of your production order 

WIP to period Current period 

Fiscal year Current year 

RA version Select 

RA version 0 

Test run Deselect 

3. Choose . 

 
As you have already entered the final confirmation for your production order, no WIP 
exists for this order. 

4. Choose  until the overview tree appears. 
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Calculating and Explaining Variances 
1. Call up the transaction as follows: 

Menu Path From the Single Functions node, choose Variances → Individual 
Processing 

Transaction Code KKS2 

2. Enter the following data: 

Field Data 

Order Number of your production order 

Period Current period 

Fiscal year Current year 

All target cost vsns Select 

Test run Deselect 

Detail list Select 

3. Choose . 

The Variance Calculation: List screen appears.  

4. Choose . 

5. Choose Input qty variance. 

The dialog box contains a definition of the term input quantity variance, as well as 
explaining how it is calculated. 

6. Choose . 

 
You can also check the other entries in the list in the same way. 

It is possible to repeat variance calculations as often as required. If you do this, 
select Test run. 

7. Choose  until the overview tree appears.  
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Settling the Production Order 
1. Call up the transaction as follows: 

Menu Path From the Single Functions node, choose Settlement → Individual 
Processing 

Transaction Code K088 

2. Enter the following data: 

Field Data 

Order Number of your production order 

Settlement period Current period 

Fiscal year Current year 

Processing type Automatic 

Test run Deselect 

3. Choose . 

You receive the basic list for the ACTUAL settlement. 

4. Choose  until the overview tree appears. 
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Data Collection for the Information System 
Use 
Before you are able to analyze data in product drilldown or use summarization or order 
hierarchies you have to use a transaction to make it available in the information system. 

Procedure 
1. Call up the transaction as follows: 

Menu Path From the Product Cost by Order node, choose Information System 
→ Tools → Data Collection → For Product Drilldown 

Transaction Code KKRV 

2. Enter the following data: 

Field Data 

Plant 1000 

From fiscal year 2000 

To fiscal year Current year 

From period 009 

To period Current period 

Background processing Deselect 

3. Choose . 

During the formatting messages relating to the data collection are displayed in the status 
bar. 

You will see all of the technical information in the Data Collection for Multidimensional 
Product Cost Controlling screen. 

4. Choose  until the overview tree appears. 

5. Call up the transaction as follows: 

Menu Path From the Data Collection node, choose: For Order Hierarchy (with 
Classification) 

Transaction Code KKRS 

6. Enter the following data: 

Field Data 

Hierarchy COPC-VAR 

Summarization run Select 

From fiscal year 2000 

To fiscal year Current year 
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From period 009 

To period Current period 

Background processing Deselect 

7. Choose . 

8. In the dialog box Summarization run online, choose Yes. 

You see a list of all the summarization nodes. 

9. Choose  until the overview tree appears. 
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The Information System for Order-Related Production 
Use 
The information system for order-related production enables you to select and analyze 
production orders from various perspectives. In the following you can familiarize yourself with 
different types of reports (cumulative reports, order selection and order hierarchies). 

Procedure 
1. Call up the transaction as follows: 

Menu Path From the Product Cost by Order node choose Information System → 
Reports for Product Cost by Order → Summarized Analysis → With 
Product Drilldown → Variance Analysis → Variance Categories → 
Cumulative 

Transaction Code S_ALR_87013148 

2. In the two following dialog boxes choose  each time. 

3. Enter the following data: 

Field Data 

Plant 1000 

From period/year 001.1995 

To period/fiscal year Current period/fiscal year 

Target cost version 0 

4. Choose . 

The Execute Drilldown Report Variance Categories: aggregated screen appears. 

You first want to analyze the variance for an existing material. To do this, proceed as 
follows: 

5. Select  Product group and open the substructure 00100 Machines. 

6. Double-click on the line Pumps, and then material P-100. 

In the upper half of the screen you will see the drilldown list of the period values and 
beneath it the detail list with the key figures for the selected area. 

7. Choose  until the overview tree appears. 

8. In the Exit Report dialog box, choose Yes. 

9. Call up the transaction for order selection as follows: 

Menu Path From the Reports for Product Cost by Order node choose Object List → 
Order Selection 

Transaction Code S_ALR_87013127 

10. Select Extras → Set Controlling Area. 
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11. In the dialog box, enter controlling area 1000 and choose . 

12. On the Order Selection screen, enter the following data: 

Field Data 

Plant 1000 

Material number P-100 

From period 001.1998 

To period Current period 

13. Choose . 

14. On the Order Selection: Results List screen, select the order number of your order, then 
choose Goto → Detailed analysis → Online... 

The Planned/Actual Comparison screen appears. 

In the Origin column you will see the material numbers for the raw materials and semi-
finished products used in the lines with cost element 400000 or 890000. 

15. Select the first line for cost element 890000 by double-clicking. 

You will see the corresponding actual costs line items. 

16. Choose  until the overview tree appears. 

17. In the dialog box, choose Yes. 

18. Call up the transaction as follows: 

Menu Path From the Reports for Product Cost by Order node choose Object List → 
Overview of Summarization Hierarchies 

Transaction Code S_ALR_87013162 

19. On the Display Hierarchy List screen, select COPC-VAR, then choose . 

20. To display an overview of the planned costs in comparison to the actual costs, choose . 

21. In the dialog box Layout: choose select 1SAP02 (Plan/actual comparison), then choose . 

22. In the dialog box Change layout select the Planned and Actual output quantities in the 
Column set. 

23. Select both of these entries, choose  and then . 

You will see the planned and actual quantities and can call up additional list screens by 
choosing  . 

24. To display an overview of the materials for the material group metal in plant 1000 open the 
substructure 001 Metal → 1000 Plant Hamburg 

25. Select Material P-100, then choose Goto → Single objects. 

In the Object list screen you will see the planned/actual comparison per order. 

26. Select your order, then choose . 

You will see the cost element report for the selected order. 
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27. Choose  until the overview tree appears. 
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Product Cost by Period with Product Cost Collectors 
Purpose 
In product cost by period the costs are analyzed by period on a product cost collector. The costs 
incurred as the result of a logistical action are updated on a product cost collector. 

In the following process product cost by period is illustrated in connection with the production 
type repetititve manufacturing. You start by analyzing the product cost collector master data and 
carry out a preliminary costing.  

You then commence producing the production line memory chips, which you confirm at various 
reporting points. You analyze the costs incurred on the product cost collector.  

At the period end you carry out the period-end closing activities for the product cost collector and 
at the same time analyze the costs.  

You can find more information about this process under  [Page 43]. 

Process Flow 
You can find the data for this process under  [Page 44] 

1. Generating the Starting Data for the IDES Process [Page 45] 

2. Displaying the Product Cost Collector [Page 46] 

3. Preliminary Costing for Product Cost Collectors [Page 48] 

4. Backflushing for the First Reporting Point  [Page 49] 

5. Analyzing the Costs for the Product Cost Collector [Page 51] 

6. Backflushing for Scrap for Reporting Point 2 [Page 52] 

7. Backflushing for the Second Reporting Point  [Page 54] 

8. Calculating Overhead Costs [Page 56] 

9. Calculating WIP [Page 58] 

10. Calculating Variances [Page 60] 

11. Settling the Product Cost Collector [Page 61] 
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Additional Process Information 
The product cost collector used in product cost by period is created on the 
material/plant/production process level, meaning the production process is specified dependent 
on a controlling level. In this process (product cost by period with the repetitive manufacturing 
production category) the controlling level determines the characteristics material/plant/production 
process. 

In this process the preliminary costing for the product cost collector is used to 

• Valuate confirmed activity quantities in actual, 

• Valuate the work in process, 

• Valuate the scrap, 

• Determine the target costs for the variance analysis. 

The following additional information is aimed at IDES users with prior knowledge of Customizing 
for Cost Object Controlling. 

You specify the settings for valuating the product cost collector for both the preliminary costing 
and the actual confirmations in the valuation variants. You assign these to this using the order 
type of the product cost collector. To check the settings choose: 

Menu Path Tools → AcceleratedSAP → Customizing → Edit Project → Choose SAP 
Reference IMG → Controlling → Product Cost Controlling → Cost Object 
Controlling → Product Cost by Period → Product Cost Collectors → 
Check Valuation Variants for Product Cost Collectors. 

Transaction Code OPN2 
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Data Used During This Process 
Field Europe North America Description 

Plant 1200 3200 Plant of the model company 

Material C-1113 C-1113 PC component 

Material R-1210 R-1210 Processor chip 

Material C-1230 C-1230  

Production version 0001 0001 Maintained production version 

Controlling area 1000 2000  

Origin of scrap 0003 0003 Defective material 

Company code 1000 3000  

Reporting point 1 0010 0010  

Reporting point 2 0030 0030  

Activity type 1420 1420 Machine hours 

RA version 000 000  
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Generating the Starting Data for the IDES Process 
Use 
To ensure that enough material is available, even if you execute this demo a number of times, 
you need to generate the necessary data using a CATT. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Tools → ABAP Workbench → Test → Test Workbench → CATT 
Transaction Code SCEM 

2. Enter the following data: 

Field Europe North America 

Test case ZIDES_STOCKINIT_PC02D ZIDES_STOCKINIT_PC02E 

3. Choose . 

4. Enter the following data: 

Field Europe North America 

Background processing Select Select 

5. Choose  and then . 

In the status bar, you see which transactions are being processed. When the CATT has 
been executed, the system creates a log confirming whether the run was successful. 

6. Choose  until the overview tree appears. 
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Displaying the Product Cost Collector 
Use 
The following shows you how to display the product cost collector. If there is no product cost 
collector you will need to create one. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Repetitive Manufacturing → Master Data → 
Product Cost Collector → Process Product Cost Collector 

Transaction Code KKF6N 

2. Enter the following data: 

Field Europe North America 

Material C-1112 C-1112 

To C-1113 C-1113 

Plant 1200 3200 

3. Choose . 

The structure of the product cost collector is displayed on the left-hand side of the screen 
Display Product Cost Collector.  

4. Open the structure of materials C-1113. 

The system displays the production process for the material. You will notice that the level 
material / plant / production version has been selected as controlling level for the product 
cost collector for material C-1113.  

5. Select production version CPU-150 assembly production line 3. 

 
If CPU-150 assembly production line 3 is not present, you will have to create a 
product cost collector. Continue with step 7. 

On the right-hand side of the screen on the tab page Data, the system displays the 
organizational data and the control information for the costing, the overhead allocation, 
the creation of work in process and the variance calculation.  

 
If CPU-150 assembly production line 3 is present, continue with step 13. 

6. Choose  Create product cost collector. 

7. In the Create product cost collector dialog box, enter the following data: 

Field Europe North America 

Material C-1113 C-1113 
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Order type RM01 RM01 

Planning Plant 1200 3200 

Production version 0001 0001 

8. Choose  Confirm. 

9. Choose the Header tab page and enter the description CPU-150 assembly production line 3 
in the field Short text.  

10. Choose Save. 

11. In the dialog box, choose Yes. 

The system informs you that the order has been created. 

12. Choose the Production Process tab page. 

The assignment of the product cost collector to the production version is done using the 
production process number.  

Note down the production process number. 

13. Remain on this screen. 
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Preliminary Costing for Product Cost Collectors 
1. You are in the Display Product Cost Collectors screen. 

2. Choose . 

3. On the Change Product Cost Collector screen, choose  Cost. 

In the status bar, you see the result of your costing run. 

4. Choose Goto → Display cost estimate. 

In the Display Material Cost Estimate with Quantity Structure screen the costing results 
are displayed with the costing structure on the left-hand side of the screen. 

5. Enlarge the left screen area to enable you to display the costing values per BOM item. 

In the upper window you can display additional information on the costing by using the 
various tab pages. 

6. Choose  to display in the lower part of the window an itemization for the costing. 

7. Choose  until the overview tree appears. 
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Backflushing for the First Reporting Point  
Use 
In this process step, you use two reporting points. At the first reporting point confirm the 
production quantity of 130 units. At this reporting point you only need parts R-1210, R-1230 and 
R1242. When you later continue production you will establish that part R-1220 is defective. 
However, you have already used 10 units for part R-1220 in the assembly and consequently 
have to scrap the 10 assembly groups concerned. You substitute R-1220 with part C-1230. 
Finally, at the second reporting point you confirm 110 units and categorize 10 units as work in 
process (130 units at reporting point 0010 less 10 units scrap, less 110 units at reporting point 
equals 10 units work in process). 

In this process the confirmation of 130 units is displayed that have been executed prior to the first 
reporting point (milestone), and also the change to the input quantity of component R-1210. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Repetitive Manufacturing → Backflush → REM 
Backflush 

Transaction Code MFBF 

2. Enter the following data: 

Field Europe North America 

Assembly backflush Select Select 

Backflush quantity 130 130 

Posting date Current date Current date 

Document date Current date Current date 

3. On the Make-to-stock tab page, enter the following data: 

Field Europe North America 

Material C-1113 C-1113 

Plant 1200 3200 

Production version 0001 0001 

RP backflush Select Select 

Reporting point 0010 0010 

4. Choose  Post with Correction. 

The components for material C-1113 are displayed.  

5. Make the following change in the line for material R-1210: 

Field Europe North America 

Quantity 65 65 
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6. Choose  Actual activities. 

7. In the Reporting Point Backflush dialog box select the first operation and choose . 

8. In the Posting actual activities screen the confirmation data is proposed. Change the required 
machine time, then enter the following data: 

Field Europe North America 

Machine Select Select 

To be backflushed 5 5 

Activity type 1420 1420 

9. Choose . 

The system displays the message: GI posted with document XXX and activities. 

10. Choose  until the overview tree appears. 
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Analyzing the Costs for the Product Cost Collector 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Cost Object 
Controlling → Product Cost by Period → Information System → Reports 
for Product Cost by Period → Detailed Reports → For Product Cost 
Collectors 

Transaction Code KKBC_PKO 

2. If the Set Controlling Area dialog box appears, enter the following controlling area and 
choose : 

Field Europe North America 

Controlling area 1000 2000 

3. Enter the following data: 

Field Europe North America 

Material C-1113 C-1113 

Plant 1200 3200 

4. Choose . 

You will see the costs per cost element in the Analyze product cost collector: screen. 

5. Choose  until the overview tree appears. 
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Backflushing for Scrap for Reporting Point 2 
Use 
In a previous process step you confirmed that 130 units have reached the first reporting point. 
You now continue production. You have removed 10 units of R-1220 from the inventory and 
included them in the assembly, but only later discovered that this part is defective. The 10 
assembly units concerned now have to be separated out as scrap. As part R-1220 is defective 
you are no longer going to use it in the production of your PC components. Instead you substitute 
R-1220 with C-1230, which is similar but a little more expensive. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Repetitive Manufacturing → Backflush → REM 
Backflush 

Transaction Code MFBF 

2. Choose  Scrap, then enter the following data: 

Field Europe North America 

Assembly backflush Select Select 

Scrap quantity 10 10 

Reason 0003 0003 

Posting date Current date Current date 

Document date Current date Current date 

3. On the Make-to-stock tab page, enter the following data: 

Field Europe North America 

Material C-1113 C-1113 

Plant 1200 3200 

Production version 0001 0001 

RP backflush Select Select 

Reporting point 0030 0030 

4. Choose  Post with Correction. 

5. In the REM Backflush Transaction Variant: None screen check the appropriate component 
withdrawals for the scrap quantity. Enter 0001 as storage location. 

6. Choose  Actual activities: 

7. In the Operation Selection for Backflushing Actual Activities select the operations and choose 
. 

8. Check the confirmation data and choose .  
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9. Check the confirmation data for this operation as well, and choose . 

10. Choose  until the overview tree appears. 

11. If the Exit Processing dialog box appears, choose Yes. 
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Backflushing for the Second Reporting Point  
Use 
You are now at the second reporting point. Up to now you have only manufactured 110 of the 
130 units that reached the first reporting point. 10 were separated out as scrap and 10 units have 
still to be manufactured. These 10 remaining units constitute work in process (WIP), and this is 
determined in one of the following processes. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Repetitive Manufacturing → Backflush → REM 
Backflush 

Transaction Code MFBF 

 

If you have not yet switched to yield backflush, choose Yield. 

2. Enter the following data: 

Field Europe North America 

Backflush quantity 110 110 

Posting date Current date Current date 

Document date Current date Current date 

3. On the Make-to-stock tab page, enter the following data: 

Field Europe North America 

Material C-1113 C-1113 

Plant 1200 3200 

Production version 0001 0001 

RP backflush Select Select 

Reporting point 0030 0030 

4. Choose  Post with Correction. 

5. On the REM Backflush – Transaction Variant: None screen select material R-1220. 

6. Choose Edit → Delete. 

7. Enter the following data: 

Field Europe North America 

Material C-1230 C-1230 

Quantity 110 110 
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Plant 1200 3200 

Storage location 0001 0001 

8. Choose  Actual activities. 

9. In the Operation Selection for Backflushing Actual Activities dialog box select your operation 
and choose . 

 
You can find additional information for analyzing the costs posted here under 
Analyzing the Costs for the Product Cost Collector [Page 51]. 

10. Choose . 

11. Choose  until the overview tree appears. 
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Calculating Overhead 
Use 
You have closed the production of your 110 units. You now need to add overhead rates to your 
production order. Such overhead is incurred for all trading goods or raw materials that have been 
withdrawn from the warehouse. The system has been set up so that an overhead rate of 15% is 
imposed on the value of the trading goods. The cost center Warehouse is credited with these 
costs, and the overhead assessed to our production order. You should note that this only 
involves a cost assignment, and that no accounting document is generated. Once all the costs 
have been collected, the production order is settled and all variances, including those caused by 
the overhead, are posted in FI by a price difference.  

When creating the run schedule header the system assigned a run schedule header number and 
a product cost collector. If you do not know the number of the cost collector, proceed as follows: 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Repetitive Manufacturing → Environment → 
Period-end Closing for Product Cost Collector → Overhead Costs → 
Individual Processing 

Transaction Code CO42 

2. Enter the following data: 

Field Europe North America 

Material C-1113 C-1113 

Plant 1200 3200 

Period Current period Current period 

Fiscal year Current year Current year 

Test run Deselect Deselect 

Detail list Select Select 

Dialog display Deselect Deselect 

3. Choose . 

The system displays the message that the overhead calculation has been completed 
without errors. 

4. Choose .  

The overhead allocated is displayed. 

 
You can find information for analyzing the costs posted here under Analyzing the 
Costs for the Product Cost Collector [Page 51]. 

5. Choose  until the overview tree appears. 
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Calculating WIP 
Use 
In this process step you specify the work in process for the production order. 

The system calculates the work in process for the 10 (130 – 10 – 110 = 10) units which had not 
been completed at the second reporting point. This means you are put in a position to determine 
the cost of goods manufactured for any material not yet transferred to the finished goods 
inventory. In this process you only create the CO document. When all costs have been collected, 
the production order is settled and the value of the work in process transferred to FI. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Starting with the Environment node choose: Period-end Closing for 
Product Cost Collector → Work in Process → Individual Processing → 
Calculate 

Transaction Code KKAS 

2. Enter the following data: 

Field Europe North America 

Material C-1113 C-1113 

Plant 1200 3200 

WIP to period Current month Current month 

Fiscal year Current year Current year 

RA version Select Select 

RA version 000 000 

Test run Deselect Deselect 

Display orders with errors Select Select 

3. Choose . 

The system displays the message that n objects have been processed and errors 
occurred in m objects. 

4. Choose WIP Explanation. 

The screen Calculate Work in Process: Object List appears and the values for each 
transaction are displayed. 

 
You can find information for analyzing the costs posted here under Analyzing the 
Costs for the Product Cost Collector [Page 51]. 

5. Choose  until the overview tree appears. 
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Calculating Variances 
1. Call up the transaction as follows: 

Menu Path Logistics → Production → Repetitive Manufacturing → Environment → 
Period-end Closing for Product Cost Collector → Variances → Individual 
Processing 

Transaction Code KKS6 

2. In the Variance Calculation: Initial Screen Choose Extras → Set Target Cost Versions.... 

3. In the dialog box Select target cost versions select target version 0 and choose Confirm. 
Confirm your entry if prompted. 

4. Choose Extras → Set Controlling Area. 

5. Make the following entry in the dialog box Set controlling area and then choose : 

Field Europe North America 

Controlling area 1000 2000 

6. Make the following entries: 

Field Europe North America 

Material C-1113 C-1113 

Plant 1200 3200 

Period Current period Current period 

Fiscal year Current year Current year 

Selected target cost versions Select Select 

Test run Deselect Deselect 

Detail list Select Select 

7. Choose . 

The Variance Calculation: List screen appears. 

 
You can find information for analyzing the costs posted here under Analyzing the 
Costs for the Product Cost Collector [Page 51]. 

8. Choose  until the overview tree appears. 
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Settling the Product Cost Collector 
Use 
In this process step you settle the cost collector to the inventory. This means that both the work 
in process and the variances (including overhead) are posted to Financial Accounting. This data 
is then included in your profit and loss statement and so enables you to make a realistic 
assessment of your products. The product costs you calculated during the manufacture of the 
products data are reduced by the work in process and scrap, and increased through the 
variances. 

Procedure 
1. Call up the transaction as follows: 

Menu Path From the Period-End Closing for Product Cost Collector node choose → 
Settlement → Individual Processing 

Transaction Code KK87 

2. Enter the following data: 

Field Europe North America 

Material C-1113 C-1113 

Plant 1200 3200 

Settlement period Current period Current period 

Posting period Current period Current period 

Fiscal year Current year Current year 

Test run Deselect Deselect 

Detail list Select Select 

3. Choose the F4 input help in the field Production Process. Production version 0001 appears.  

4. Choose . 

5. Choose  in the Actual Settlement: Product cost collector Basic List screen. 

6. In the Actual Settlement Product cost collectors Detail List screen select the values that have 
been settled. 

You will see the settlement of the variances for the product cost collector. 

7. Choose . 

In the detail list Results analysis data for FI you will see the change to the work in 
process for the product cost collector. 

8. Choose  until the overview tree appears. 
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Product Costing by Period for an Individual Material 
Purpose 
When products are costed by period for an individual material, the costs incurred for production 
are displayed on a product cost collector without reference to the sales order. 

When you post the goods receipt for the finished material, the system valuates this material and 
credits the product cost collector. These actions reflect the value determined by the cost estimate 
marked for the sales order item. This value is also used to display the cost of goods 
manufactured (COGM) on the sales order in Profitability Analysis (CO-PA). 

At period end, the variances on the product cost collector are settled to the material. These 
variances are not displayed in detail for the customer and the material in Profitability Analysis. 
They are displayed only for the overall material. 

Process Flow 
You can find the data for this process under  [Page 63]. 

1. Changing the Material Master Record [Page 64] 

2. Creating a Sales Order [Page 65] 

3. Checking Order Data in CO-PA [Page 67] 

4. Executing Material Requirements Planning [Page 68] 

5. Costing the Product Cost Collector [Page 69] 

6. Execute Goods Receipt Notification [Page 70] 

7. Execute Separated Backflush [Page 71] 

8. Calculating Overhead Costs [Page 72] 

9. Analyzing Costs on Product Cost Collectors [Page 73] 

10. Posting a Goods Issue [Page 74] 

11. Creating a Billing Document [Page 75] 

12. Calculating Variances [Page 76] 

13. Settle Variances to CO-PA [Page 77] 

14. Displaying the Results of the Sales Order [Page 78] 

15. Resetting the Master Data Record [Page 79] 
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Data Used During This Process 
Field Data Description 

Material AM2-GT Sapsota Fundrive 

Plant 1000 Hamburg 

Sales organization 1000 Germany Frankfurt 

Distribution channel 12 Repeat buyer 

Division 00 Cross-divisional 

Operating concern IDEA Global IDES 

Type of Profitability Analysis Costing-based  

Profitability Reports IDES-350 Results analysis 
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Changing the Material Master Record 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Material Master → Material → 
Change → Immediately 

Transaction Code MM02 

2. Enter the following data: 

Field Data 

Material AM2-GT 

3. Choose Select view(s). 

4. In the dialog box, choose . 

5. Select the line MRP4. 

6. Choose Organizational levels. 

7. In the Organizational Levels dialog box, enter the following data: 

Field Data 

Plant 1000 

8. Choose . 

9. Check the entries in the screen Change Material AM2-GT (Finished product) and change 
them as necessary: 

Field Data 

Repetitive manufacturing Select 

REM profile A002 

10. Choose . 

You receive the message Material AM2-GT changed (if relevant). 

11. Choose . 
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Creating a Sales Order 
1. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

2. Enter the following data: 

Field Data 

Order type OR 

Sales organization 1000 

Distribution channel 12 

Division 00 

3. Choose . 

4. Enter the following data: 

Field Data 

Sold-to party 1012 

Purch. order no Any six figure number 

Req.deliv.date Today’s date + 10 working days 

Material AM2-GT 

Order quantity 1 

5. Choose . 

6. In the Information dialog box, choose . 

7. To configure the product, enter the following data: 

Field Data 

Motor Motor 6 cyl. 112 kW 

Transmission (02) Automatic 

Paint (USC) Black (plain) 

Trim (L) Leather 

Interior color (S) Black 

Options (KA) Air conditioning 

(BC) Navigation system 

(RBU) Radio business sound 

8. Choose Conditions. 

In the Create Standard Order: Overview dialog box, you see the prices for the optional 
extras. 
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9. Choose . 

10. Choose . 

11. In theCreate Standard Order: Overview screen, select the row for item 10, then choose 
Extras → Costing. 

12. On the screen Sales Order Costing choose . 

The costing is displayed. 

13. Choose . 

You receive the warning Marked cost estimates generated for material valuation. 

14. Choose . 

15. Choose . 

16. In the dialog box Update Parameters, choose . 

17. Choose . 

The system displays the message Standard Order XXX has been saved. 

18. Make a note of the sales order number. 

19. Choose . 

20. In the Cancel Order Processing dialog box, choose Yes. 

21. Choose . 
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Check Order Data in CO-PA 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Information System 
→ Display Line Item List → Actual 

Transaction Code KE24 

2. In the Set Operating Concern dialog box, enter the following data: 

Field Data 

Operating concern IDEA 

Type of Profitability Analysis Costing-based 

3. Choose . 

4. On the Display Actual Line Items: Initial Screen screen, enter the following data: 

Field Data 

Currency type B0 

Record type A 

Period/year Current month / year 

Sales order No. of the sales order you created 

5. Choose . 

On the Display Actual Line Items: List screen, you see the document you have created. 
This contains the order data relevant for Profitability Analysis (record type A). As well as 
the order data, the billing data are also transferred into Profitability Analysis. 

6. Select this document, then choose . 

On the Display Line Items screen, you see the details of the selected Profitability 
Analysis document. In the top area of the screen, you see general data, such as the 
document number. The Characteristics tab page contains the characteristic attributes 
specified in the account assignment or derived by the system. Characteristics exist for all 
dimensions that can be used for analysis purposes in Profitability Analysis. 

7. Choose the Value fields tab page. 

This tab page contains detailed information about the order quantity, revenue, discounts 
and various items relating to the cost of goods manufactured. The COGM are transferred 
from the standard cost estimate for the sales order. 

8. Choose  until the overview tree appears. 
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Executing Material Requirements Planning 
9. Call up the transaction as follows: 

Menu Path Logistics → Production → MRP → Planning → Single-Item, Multi-Level 

Transaction Code MD02 

10. Enter the following data: 

Field Data 

Material AM2-GT 

Plant 1000 

Processing key NETCH 

Create purchase req. 2 

Schedule lines 3 

Create MRP list 1 

Planning mode 3 

Scheduling 1 

Also plan unchanged components Select 

Display material list Select 

11. Choose  twice. 

12. Choose  and  until the overview tree appears. 

 
 

68  April 2001 



 SAP AG Product Cost Controlling (CO-PC) 

  Costing the Product Cost Collector 

Costing the Product Cost Collector 
13. Call up the transaction as follows: 

Menu Path Logistics → Production → Repetitive Manufacturing → Master Data → 
Product Cost Collector → Process Product Cost Collector 

Transaction Code KKF6N 

14. If material AM2-GT is not displayed yet make the following entries in the Display Product 
Cost Collector: 

Field Data 

Material AM2-GT 

Plant 1000 

15. Choose . 

16. On the left hand side of the screen open the structure of AM2-GT to display the related 
product cost collector. 

17. Select the lower entry of SAPSOTA FUN DRIVE 2000GT. 

18. Choose . 

19. On the Change Product Cost Collector screen, choose  Cost. 

20. Choose Goto → Display cost estimate. 

Unlike the sales order the product cost collector is subject to a preliminary costing with a 
variant of AM2-GT, where it is assumed that this represents an ‘average’ configuration. 

21. Choose . 

22. Choose . 

The system displays the message Product cost collector with order number ### has 
been changed. 

23. Choose . 
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Execute Goods Receipt Notification  
24. Call up the transaction as follows: 

Menu Path Logistics → Production → Repetitive Manufacturing → Backflush → REM 
Backflush 

Transaction Code MFBF 

25. Choose the Make-to-order tab page. 

26. Enter the following data: 

Field Data 

Sales order noted sales order number 

Sales ord. item 10 

27. Choose . 

28. Choose . 

29. In the Maintain Serial Numbers dialog box, choose Create SerialNo automatically and then 
. 

30. Choose . 
31. If the Exit Processing dialog box appears, choose Yes. 
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Execute Separated Backflush 
32. Call up the transaction as follows: 

Menu Path Logistics → Production → Repetitive Manufacturing → Backflush → 
Separated Backflush 

Transaction Code MF70 

33. Enter the following data: 

Field Data 

Post goods issue Select 

Post production activities Select 

Make-to-stock Deselect 

Make-to-order production Select 

KANBAN Deselect 

Plant 1000 

Posting date Current date 

Sales order Your sales order number 

Sales order item 10 

34. Choose . 

35. Choose . 

36. Choose  until the overview tree appears. 
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Calculating Overhead Costs 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Cost Object 
Controlling → Product Cost by Period → Period-End Closing → Single 
Functions: Product Cost Collector → Overhead → Individual Processing 

Transaction Code CO42 

2. In the Set controlling area dialog box, enter the following data: 

Field Data 

Controlling area 1000 

3. Choose . 

4. Enter the following data: 

Field Data 

Material AM2-GT 

Plant 1000 

Prod. process number Pversion:0001 

Period Current period (month) 

Fiscal year Current year 

Test run Deselect 

Detailed lists Select 

5. Choose . 

The Actual Overhead Calculation: Product cost collector Basic List screen appears. 

6. Choose . 

7. Choose  until the overview tree appears. 
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Analyzing Costs on Product Cost Collector 
37. Call up the report as follows: 

Menu Path From the Cost Object Controlling node choose: Product Cost by Period → 
Information System → Reports for Product Cost by Period → Detailed 
Reports → For Product Cost Collectors 

Transaction Code KKBC_PKO 

38. Enter the following data: 

Field Data 

Material AM2-GT 

Plant 1000 

Production process Pversion:0001 

Time frame: Limited select 

Period from Current period 

To period Current period 

39. Choose . 

In the Total column, you see all the debits and credits for the reporting period. For each 
sales order, the system displays the debits (charges) due to the consumption of 
materials and activity (labor), and also the credits posted to the production cost collector 
in accordance with the sales order costing for the goods issue notification. When you use 
costing sheet COGM, the overhead costs are only applied when you calculate the 
overhead [Page 72]. 

40. Choose  until the overview tree appears. 
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Posting a Goods Issue 
41. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Shipping and Transportation → 
Outbound Delivery → Create → Single Document → With Reference to 
Sales Order 

Transaction Code VL01N 

42. Enter the following data: 

Field Data 

Shipping point 1000 

Selection date Today’s date + 1 month 

Order Your sales order number 

43. Choose . 

44. In the Delivery create: Overview screen select the Picking tab page. 

45. Enter the following data: 

Field Data 

SLoc 0002 

Pick Quantity 1 

46. Choose . 

47. As the product requires a serial number, select the item, then choose Extras → Serial 
numbers. 

48. In the Maintain Serial Numbers dialog box, choose Create SerialNo automatically. 

49. Choose . 

50. Choose Post goods issue. 

The system displays the message Delivery XXX has been saved. 

51. Choose . 
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Creating a Billing Document 
52. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Billing → Billing document → Create 

Transaction Code VF01 

53. Enter the following data: 

Field Data 

Document number Accept predefined document number 

54. Choose . 

55. Choose . 

The system displays the message Document XXX has been saved. 

56. Choose . 
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Calculating Variances 
57. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Cost Object 
Controlling → Product Cost by Period → Period-End Closing → Single 
Functions: Product Cost Collector → Variances → Individual Processing 

Transaction Code KKS6 

58. Enter the following data: 

Field Data 

Material AM2-GT 

Plant 1000 

Prod. process no. Pversion:0001 

Period Current period 

Fiscal year Current year 

Selected target cost versions Select 

Test run Deselect 

Detail list Select 

59. Choose . 

60. Select the data record displayed in the screen Variance Calculation: List and choose . 

The resulting variance amounts to the sum of the variances on the input and output side 
respectively. 

 
The variance on the input side is the difference between the control costs and the 
target costs. The control costs are the costs (actual costs) posted for the sales order 
on the product costs collector, less the work in process and scrap. The target costs 
are equivalent to the standard price multiplied by the order quantity. The standard 
price originates from a released standard cost estimate. 

The variance on the input side is the difference between the control costs and the 
target costs. The actual costs allocated represent the credit of the product cost 
collector for the costs as have been calculated in the appropriate sales order. 

61. Choose  until the overview tree appears. 
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Settling Variances to CO-PA 
62. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Cost Object 
Controlling → Product Cost by Period → Period-End Closing → Single 
Functions: Product Cost Collector → Settlement → Individual Processing 

Transaction Code KK87 

63. Enter the following data: 

Field Data 

Material AM2-GT 

Plant 1000 

Prod. process number Pversion:0001 

Settlement period Current period 

Posting period Current period 

Fiscal year Current year 

Test run Deselect 

Detail list Select 

64. Choose . 

The Actual Settlement: Product cost collector Basic List screen appears. 

65. Choose  until the overview tree appears. 
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Displaying the Results of the Sales Order 
66. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Profitability Analysis → Information System 
→ Execute Report 

Transaction Code KE30 

67. In the report list select IDES-350 (Results Analysis AM2-GT). 

68. Choose . 

69. On the Selection: Results analysis AM2_GT screen, enter the following data: 

Field Data 

From fiscal year Current year 

From period Current period 

To period Current period 

70. Choose . 

The system displays a profitability report for material AM2-GT, initially displaying the 
detail list. The variances are also displayed in addition to the sales data and cost of 
goods manufactured. 

71. In the Navigation area choose Customer.  

72. In the screen Drill-down: Callup for documentation on hotspots choose . 

The system now displays the data at customer level, specifically for customer 1012. The 
variances are not included in this view. They cannot be assigned to an individual 
customer, because Lean Controlling has been used in the production area. This means 
that there is no reference to the customer in this area. 

The values displayed originate from the costing performed when you created the 
standard order for this customer and from the invoice. 

73. Choose  until the overview tree appears. 

74. In the Exit Report dialog box, choose Yes. 
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Resetting the Material Master Record 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Material Master → Material → 
Change → Immediately 

Transaction Code MM02 

2. Enter the following data: 

Field Data 

Material AM2-GT 

3. Choose Select view(s). 

4. In the dialog box, choose . 

5. Select the line MRP4. 

6. Choose Organizational levels. 

7. In the Organizational Levels dialog box, enter the following data: 

Field Data 

Plant 1000 

8. Choose . 

The Change Material AM2-GT (Finished product) screen appears. 

9. Choose the MRP 4 tab page. 

10. Check the following entries and if necessary change them as appropriate: 

Field Data 

REM profile A001 

11. Choose . 

You receive the message Material XXX changed (if relevant). 

12. Choose . 
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Executing Multilevel Price Determination 
Purpose 
Multilevel price determination is used to calculate the actual prices of externally 
procured and in-house materials. The calculation of actual prices can be used to 
valuate the period-end inventory.  In addition, the Actual Costing/Material Ledger 
component provides you with numerous tools which you can use to analyze the 
actual prices. 
The following scenarios are envisaged for multilevel price determination: 
• Carrying out multilevel price determination and a simple analysis 

• Analysis for multilevel price determination with the actual cost component split, and 
integration with Profitability Analysis 

In the example used, you carry out multilevel price determination at the period 
end, and analyze the results. 
You can find more information about this example under  [Page 82] 

Prerequisites 
To calculate the actual costs at the period end you must have set the material 
ledger in the relevant controlling area to active, and you must specify that the 
materials are included in the actual costing. 

Process Flow 
You can find the data for this example under  [Page 84] 
1. Creating a Purchase Order [Page 85] 

2. Entering the Goods Receipt [Page 87] 

3. Entering the Invoice [Page 88] 

4. Post Consumption to Cost Center [Page 89] 

5. Creating a Production Order [Page 90] 

6. Confirming the Production Order [Page 91] 

7. Production Order Period-end Closing [Page 92] 

8. Material Transfer Posting [Page 95] 

9. Sale to External Customers [Page 96] 

10. Entering the External Invoices [Page 98] 

11. Completing Period-End Closing in Cost Center Accounting [Page 100] 

12. Analyzing the Material Inventory Values Before Period-End Closing [Page 102] 

13. Creating a Costing Run for Single-level Price Determination [Page 104] 
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14. Analyzing Single-level Price Determination [Page 107] 

15. Creating a Costing Run for Multilevel Price Determination [Page 109] 

16. Analyzing Multilevel Price Determination [Page 112] 
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Additional Process Information 
In the examples designed to illustrate price determination in the IDES Company, you are 
operating in the following business management environment:  

The IDES Company in Mexico (company code 6000) is carrying out the price determination and 
is involved in the production and sale of demo CD´s. There are two plants in Mexico: plant 6000 
is in Mexico City, and plant 6100 in Monterrey. The demo CD’s are produced in plant 6000. 

The following graphic illustrates the organizational and production structure: 

Plant 6000

Label
ACT-LCD

Blank CD
ACT-BCD

Demo CD
ACT-DCD

Plant 6100 Demo CD
ACT-DCD

Industrias
Pacificas

6666

Studios
Chapultepec

1099

New 
Machine

FV01

Puebla 
Digital
1097

Fabricas
Mixtli
1096

Productos
Argentions

1098

Plant 6000

SaleTransfer
 Posting

Order

Order Order Order

Product 
Cost Collector

 
The demo CD’s are produced in the plant in Mexico City, being either sold or transferred to the 
other plant in Monterrey. The materials to be used in the production process – blanks and labels 
– are externally procured. 

When you use price determination all goods movements are provisionally valuated with the 
standard price, and differences between this provisional valuation and the values actually posted 
are collected as price and exchange rate differences in the material ledger. 

At the period end the periodic unit price (actual price) is determined for all materials, taking into 
account all of the price and exchange rate differences, and you can use this to revaluate the 
period end closing stock balance if you wish. 
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Since the material ledger updates all goods movements in one separate quantity structure, it is in 
a position to roll up price and exchange rate differences for materials to materials of a higher 
manufacturing level. This means that price variations for raw materials are taken into account in 
the prices of the finished products. 
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Data Used During This Process 
Field Data 

Vendor 1096; 1097; 1098; 1099 

Purchasing org. 6000 

Sales org. 6000 

Purchasing group 600 

Company code 6000 

Material ACT-LCD; ACT-BCD; ACT-DCD 

PO quantity 1000; 500; 200 

Plant 6000 

Receiving plant 6100 

Storage location 0001 

Receiving storage location 0001 

Amount 280 

Currency MXN 

Tax code V0 

Movement type 201; 301 

Cost center 530CC1; 530CC2 

Order type PP08; TA 

Controlling area 6000 

Distribution channel 10 

Division 00 

Sold-to party 6666 

Shipping point 6000 

Business process 300200 

Costing run ACT530 
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Creating a Purchase Order 
Use 
In order to be able to carry out multilevel price determination, you make various goods postings 
within this process step. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Purchasing → Purchase Order → 
Create → Vendor/Supplying Plant Known 

Transaction Code ME21N 

2. Enter the following data: 

Field Data 

 (Document type) Standard purchase order 
Vendor 1096 

3. Choose  Header, and then enter the following data in the Org.data tab page: 

Field Data 

Purchasing organization 6000 
Purchasing group 600  
Company code 6000 

4. Choose  Item Overview, then enter the following data: 

Field Data 

Material ACT-LCD 
PO quantity 1000 
Plant 6000 
Storage location 0001 

5. Choose . 

You can see that some of the entries have been drawn from an information record, for 
example net price or delivery date. 

6. Choose . 

The system displays the message Standard PO created under number XXX. 

7. Note this number. 

8. Repeat steps 2 to 5 entering the following data: 

Field Data Data Data 
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Document type Standard purchase 
order 

Standard purchase 
order 

Standard purchase 
order 

Vendor 1097 1098 1099 
Purchasing org. 6000 6000 6000 
Company code 6000 6000 6000 
Material ACT-BCD ACT-BCD ACT-DCD 
PO quantity 500 500 200 
Plant 6000 6000 6000 
Storage location 0001 0001 0001 

9. If you are requested to enter a Purchasing group then enter 600 in the relevant field and 
choose  again. 

10. Choose  until the overview tree appears. 

 

86  April 2001 



 SAP AG Product Cost Controlling (CO-PC) 

  Entering the Goods Receipt 

Entering the Goods Receipt 
11. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Goods Receipt → For Purchase Order → PO Number 
Known 

Transaction Code MIGO 

12. Enter the following data: 

Field Data 

Goods receipt/Purchase order Order number created first 

Document date Current date 

Posting date Current date 

13. Choose . 

14. In the lower screen area, enter the following data: 

Field Data 

Item OK Select 

15. Choose . 

16. Repeat steps 2 to 5 for all of the purchase orders. 

17. Choose  until the overview tree appears. 
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Entering the Invoice 
18. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Logistics Invoice Verification → 
Document Entry → Enter Invoice for Invoice Verification 

Transaction Code MIRO 

19. If the Company code dialog box appears, enter 6000 and choose : 

20. Enter the following data: 

Field Data 

Invoice date Current date 
Posting date Current date 
Amount, first field/second field 280 / MXN 
Calculate tax Select 
Tax code V0 

21. On the PO reference tab page in the lower part of the screen, enter the following data: 

Field Data 

Purchasing order/scheduling agreement Order number for vendor 1096 

22. Choose . 

23. In the tab page PO reference adjust the Amount to the amount entered above. 

24. Choose . 

The document was posted. 

25. Choose  until the overview tree appears. 
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Post Consumption to Cost Center 
26. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Goods Issue (MIGO) 

Transaction Code MIGO_GI 

27. In the screen Goods Issue Reservation select the entry Others in the Reservation field using 
the input help. 

28. On the General tab page, enter the following data: 

Field Data 

Document date Current date 
Posting date Current date 

29. On the Material tab page, enter the following data: 

Field Data 

Material ACT-LCD 

30. Choose the quantity (Qty) tab page. 

31. Enter the following data: 

Field Data 

Qty in unit of entry 200 

32. Choose the Wk tab page. 

33. Enter the following data: 

Field Data 

Movement type 201 

Plant 6000 
Storage location 0001 

34. Choose . 

35. Choose the Acct Assignment tab page. 

36. Enter the following data: 

Field Data 

Cost center 530CC1 

37. Choose . 

The system displays the message: Material Document XXX posted 

38. Choose  until the overview tree appears. 
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Creating a Production Order 
39. Call up the transaction as follows: 

Menu Path Logistics → Production → Production control → Order → Create → With 
material 

Transaction Code CO01 

40. Enter the following data: 

Field Data 

Material ACT-DCD 
Production plant 6000 
Order type PP08 

41. Choose . 

42. On the Create Production Order: Header screen, enter the following data: 

Field Data 

Total quantity (under Quantities) 800 
Finish (under Dates) Current date 

43. Choose . 

44. Choose . 

45. Choose . 

The system displays the message Order number XXX saved. 

46. Note this number. 

47. Choose  until the overview tree appears. 
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Confirming the Production Order 
48. Call up the transaction as follows: 

Menu Path Logistics → Production → Production control → Confirmation → Enter → 
For order 

Transaction Code CO15 

49. Enter the following data: 

Field Data 

Order Your order number 

50. Choose . 

51. On the Confirmation of Production Order Create : Actual data enter the following data: 

Field Data 

Final confirmation Select 
Yield to confirmation, (first field/second field) 750 / ST 
Confirmed scrap 50 
Posting date Current date 

52. Choose . 

The system displays the message Confirmation saved (Goods movements: 3, failed: 0) 

53. Skip any warning messages displayed by choosing . 

54. Choose  until the overview tree appears. 
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Production Order Period-end Closing 
55. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Cost Object 
Controlling → Product Cost by Period→ Period-End Closing → Single 
Functions: Product Cost Collector→ Overhead → Individual Processing 

Transaction Code CO42 

A dialog box appears if you have not yet set the controlling area. 

56. In the dialog box, enter the following data: 

Field Data 
Controlling area 6000 

57. Choose . 

58. On the Actual Overhead Calculation: Product cost collector screen, enter the following data: 

Field Data 

Material ACT-DCD 
Plant 6000 
Period Current period 
Year Current fiscal year 
Test run Deselect 

59. Choose . 

You receive the results of the overhead. 

60. Choose  until the overview tree appears. 

61. Call up the transaction for the variance calculation as follows: 

Menu Path From the Single Functions. Product Cost Collector node, choose 
Variances → Individual Processing 

Transaction Code KKS6 

62. On the Variance Calculation: Initial Screen, enter the following data: 

Field Data 

Material ACT-DCD 
Plant 6000 
Period Current period 
Fiscal year Current fiscal year 
Test run Deselect 

63. Choose . 

You receive the results of the variance calculation. 
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64. Choose  until the overview tree appears. 

65. Call up the transaction for the settlement as follows: 

Menu Path From the Single Functions: Product Cost Collector node, choose 
Settlement → Individual Processing 

Transaction Code KK87 

66. Enter the following data: 

Field Data 

Material ACT-DCD 
Plant 6000 
Period Current period 
Fiscal year Current fiscal year 
Test run Deselect 

67. Choose . 

You receive the results of the settlement. 

68. Choose  until the overview tree appears. 
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Material Transfer Posting 
69. Call up the transaction as follows: 

Menu Path Logistics → Materials Management → Inventory Management → Goods 
Movement → Transfer Posting 

Transaction Code MB1B 

70. Enter the following data: 

Field Data 

Document date Current date 

Posting date Current date 

Movement type 301 

Plant 6000 

Storage location 0001 

71. Choose . 

72. On the Enter Transfer Posting: New Items screen, enter the following data: 

Field Data 

Receiving plant 6100 

Recv. SLoc 0001 

Material ACT-DCD 

Quantity 100 

73. Choose . 

The system displays the message: Document XXX posted 

74. Choose  until the overview tree appears. 
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Sale to External Customers 
75. Call up the transaction as follows: 

Menu Path Logistics → Sales and Distribution → Sales → Order → Create 

Transaction Code VA01 

76. Enter the following data: 

Field Data 

Order type OR 

Sales organization 6000 

Distribution channel 10 

Division 00 

77. Choose . 

78. On the Create Standard Order: Overview screen, enter the following data: 

Field Data 

Sold-to party 6666 

PO number Your initial one + the current date 

Material ACT-DCD 

Quantity 100 

79. Choose . 

The system displays the message Standard Order XXX has been saved. 

80. Note this number. You will need it again later. 

81. Choose  until the overview tree appears. 

82. In the dialog box, choose No. 

83. Call up the transaction for the delivery of the material to the customer as follows: 

Menu Path From the node Sales and Distribution choose Shipping and Transportation 
→ Outbound Delivery → Create → Single Document → With Reference to 
Sales Order 

Transaction Code VL01N 

84. Enter the following data: 

Field Data 

Shipping point 6000 

Selection date Today’s date +30 days 
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Order Your order number 

85. Choose . 

86. In the screen Delivery create: overview select the tab page Picking. 

87. Enter the following data: 

Field Data 

Storage location 0001 

Picking Quantity 100 
88. Choose Post goods issue. 

The system displays the message Delivery XXX saved. 

89. Note this number. 

You will need it again later. 

90. Choose  until the overview tree appears. 

91. Call up the transaction for creating a billing document as follows: 

Menu Path From the Sales and Distribution node, choose Billing → Billing Document 
→ Create 

Transaction Code VF01 

92. Enter the following data: 

Field Data 

Billing document Current date 

93. Choose . 

The system displays the message Document XXX saved. 

94. Choose  until the overview tree appears. 

 

April 2001  97 



Product Cost Controlling (CO-PC)  SAP AG 

Entering the External Invoices 

Entering the External Invoices 
95. Call up the transaction as follows: 

Menu Path Accounting → Financial Accounting → General Ledger → Document Entry 
→ Enter G/L Account Document 

Transaction Code FB50 

96. Enter the following data: 

97. If the Company code dialog box appears, enter the following data and choose : 

Field Data 

Company code 6000 

98. Enter the following data: 

Field Data 

Document date Current date 
Posting date Current date 
Currency MXN 

99. In the Items screen area, enter the following data: 

 
To make this simpler, you can move the relevant columns so that all of the 
corresponding input fields are at the front end of the table. 

Field 

G/L account D/C Amount in 
doc. currency 

Tax code Cost center Business 
process 

Data 
404000 D 12 V0  300200 

404000 D 37 V0 530CC1  
415000 D 5 V0  300200 

415000 D 19 V0 530CC2  
416100 D 5 V0  300200 

416100 D 19 V0 530CC2  
416100 D 74 V0 530CC1  
416300 D 10 V0  300200 

416300 D 55 V0 530CC1  
416300 D 19 V0 530CC2  
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420000 D 2   300200 

420000 D 37  530CC2  
421000 D 10   300200 

421000 D 155  530CC1  
421000 D 51  530CC2  
430000 D 14   300200 

430000 D 214  530CC1  
430000 D 25  530CC2  
481000 D 12   300200 

481000 D 19  530CC2  
100000 C 794    

100. Choose . 

The system displays the message: Document XXX posted in company code 6000. 

101. Choose  until the overview tree appears. 

In the Exit Processing dialog box, choose Yes. 
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Completing Period-End Closing in Cost Center 
Accounting 
Use 
You want to calculate actual prices within period-end closing for Cost Center Accounting. With 
the actual price calculation you also receive the cost component split for the actual allocation 
records. 

Procedure 
102. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Cost Center Accounting → Period-End 
Closing → Single-Functions → Splitting. 

Transaction Code KSS2 

103. Enter the following data: 

Field Data 

All cost centers Select 
Version 0 
Period Current period 
Fiscal year Current fiscal year 
Test run Deselect 

104. Choose . 

You receive the actual cost component split log. 

105. Choose  until the overview tree appears. 

106. Call up the transaction for the actual price calculation as follows: 

Menu Path From the Single Functions node, choose Price Calculation 

Transaction Code KSII 

107. Enter the following data: 

Field Data 

All cost centers Select 
No business processes Select 
Version 0 
Period Current period 
Fiscal year Current fiscal year 
Test run Deselect 
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108. Choose . 

109. In the Information dialog box, choose . 

You receive the actual cost component split log. 

110. Select entry 530CC2/530AT2 and choose Goto → Components. 

You receive the cost component split for the selected allocation record. 

111. Choose  until the overview tree appears. 

112. In the End price calculation dialog box, choose Yes. 
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Analyzing the Material Inventory Values Before Period-
End Closing 
Use 
You display the inventory values and valuation of the CD labels before the multilevel price 
determination, and note down some of these values. 

Procedure 
113. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Actual 
Costing/Material Ledger → Material Ledger → Material Price Analysis 

Transaction Code CKM3 

114. Enter the following data: 

Field Data 

Material ACT-LCD 
Plant 6000 
Period/year Current period/current fiscal year 
Currency Company code currency 
View Price determination structure 

115. Choose  Prices and inventory values. 

116. Open the category Consumption in the price determination structure, in order to display 
the lines Production and Cost center 

117. Check the following entries for the current period: 

Field Data 

Period status Quantities and values entered 

Standard price XXX 

Periodic unit price XXX 

Price control S 

Current stock value XXX 

Inv. value (stat.) XXX 

In the lower screen area: 

Cumulative inventory XXX 

Consumption XXX 

Production XXX 
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Cost center XXX 

Ending inventory XXX 

The data relevant for this process is found in the cells in the table indicated with XXX. 

118. Choose  until the overview tree appears. 
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Creating a Costing Run for Single-level Price 
Determination 
Use 
Multilevel price determination is executed at plant level. In the following process steps you create 
a costing run for the plants in controlling area Mexico, and carry out the individual flow steps. 

Prerequisites 
You can only post the multilevel price determination for the respective previous MM period. 
Therefore you have to close the current period so that the following month is now the ‘current’ 
MM period. 

Procedure 
119. Call up the transaction as follows: 

Menu Path Logistics→ Materials Management → Material Master → Other → Close 
Period 

Transaction Code MMPV 

120. Enter the following data: 

Field Data 

From company code 6000 
Enter next period Current period + 1 
Fiscal year Current fiscal year 
Check and close period Select 

121. Choose . 

You receive the close period log. 

122. Choose  until the overview tree appears. 

123. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Actual 
Costing/Material Ledger → Actual Costing → Edit Costing Run 

Transaction Code CKMLCP 

124. On the Costing Cockpit: Actual Costing – Change/Execute screen, enter the following 
data: 

125.  

Field Data 

Costing run (1 field / 2 field) ACT530 / Actual costing period/year 
Period Current period/current fiscal year 
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126. Choose  (Create costing run). 

127. In the dialog box Create costing run, choose . 

In the screen Costing Cockpit: Actual Costing – Change / Execute the system displays in 
the settings area those plants for which a costing run is to be carried out.  

128. Assign the available plants 6000 and 6100 to the costing run. 

These plants are now under the area Assigned plants. 

129. Choose . 

130. To display the individual process steps of the costing run, choose  Process. 

131. Select the row Selection, then choose  (Change parameters). 

132. In the screen Maintain Variant: Report SAPCKMLMV_RUN_BASIC_LIST, Variant, enter 
the following data: 

Field Data 

Background processing Deselect 
Save log Select 

133. Choose . 

134. Choose . 

135. Select the row Selection, then choose  (Execute). 

The system displays the results log for the selection. 

136. Choose . 

137. In the screen Costing Cockpit: Actual Costing – Change / Execute select the process 
step Determine sequence and choose . 

138. In the screen Maintain Variant: Report SAPCKMLMV_CREATE_STEPS, Variant, enter 
the following data: 

Field Data 

Background processing Deselect 
Save log Select 

139. Choose . 

140. Choose . 

141. Select the row Determine sequence, then choose . 

The system displays the results log. You can see which materials have been assigned to 
the various costing/manufacturing levels. 

142. Choose . 

143. In the screen Costing Cockpit: Actual Costing – Change / Execute select the process 
step Single-level price determination and choose . 
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144. In the screen Maintain Variant: Report SAPRCKMA_RUN_SETTLE, Variant enter the 
following data: 

Field Data 

Treating materials already processed Select 
Background processing Deselect 
Save log Select 

145. Choose . 

146. Choose . 

147. In the screen Costing Cockpit: Actual Costing – Change / Execute select the process 
step Single-level price determination and double-click on . 

This allows single-level and multilevel price determination. 

148. Select the row Single-level price determination, then choose . 

The system displays the results log. The system displays which materials have been 
successfully costed. 

149. Choose  until the overview tree appears. 
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Analyzing the Single-Level Price Determination 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Actual 
Costing/Material Ledger → Material Ledger → Material Price Analysis 

Transaction Code CKM3 

2. Enter the following data: 

Field Data 

Material ACT-LCD 
Plant 6000 
Period/year Current period/current fiscal year 
Currency Company code currency 

3. Choose  Prices and inventory values. 

4. Open the category Consumption in the price determination structure, in order to display the 
lines Production and Cost center 

5. Check the following entries for the current period: 

Field Data 

Period status Price determined single-level 

Standard price XXX 

Periodic unit price XXX 

Price control S 

Current stock value XXX 

Inv. value (stat.) XXX 

In the lower screen area: 

Cumulative inventory XXX 

Consumption XXX 

Production XXX 

Cost center XXX 

Ending inventory XXX 

 
The row Not allocated displays the price differences for the consumption of the 
material. These values are only allocated during the multilevel price determination. 
The data relevant for this process is found in the cells in the table indicated with 
XXX. 
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6. Open the category Ending inventory in the overview list and display the material ledger 
document for singe-level price determination. 

7. Double-click on the appropriate line in the document. 

You will see the line item displayed. 

8. Choose  until the overview tree appears. 
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Creating a Costing Run for Multilevel Price 
Determination 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Actual 
Costing/Material Ledger → Actual Costing → Edit Costing Run 

Transaction Code CKMLCP 

2. In the screen Costing Cockpit: Actual Costing – Change / Execute select the process step 
Multilevel price determination and choose . 

3. In the screen Maintain Variant: Report SAPRCKMA_RUN_MLEVEL_SETTLE, Variant, enter 
the following data: 

Field Data 

Background processing Deselect 
Save log Select 

4. Choose . 

The system displays the message Values of variant XXX saved. 

5. Choose . 

6. Choose  in the row Multilevel price determination. 

The system displays the results log. The system displays which materials have been 
successfully costed. 

7. Choose . 

8. To display the materials included in the costing run, choose  Costing results. 

9. Enter the following data: 

Field Data 

View Overview: Costing Run 
Hierarchy CstngRun/plant/mat. type/val. class/origin group 

10. In the area Results select your costing run and using the right mouse button choose Display 
material list. 

On the right-hand side of the screen you will see the materials selected with their 
corresponding processing status 

11. To obtain an overview of the material movements, choose   → Select layout  

12. In the dialog box Choose layout select the entry Transaction data. 

The system displays the materials selected for the price determination together with their 
transaction data. 

13. To display the price differences per material choose   → Select Layout. 

14. In the dialog box Choose layout select the entry Price analysis. 
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The system displays the materials selected for the price determination together with their 
price differences. 

15. To analyze the origin of the price differences for your demo CD’s, double-click on the 
corresponding material in plant 6100 in the area Display material list. 

The material ledger for your demo CD is displayed. 

16. Choose   → Select layout. 

17. In the dialog box Choose layout select the entry Single- and multilevel differences and 
choose Copy. 

18. Make a note of the single and multilevel differences from the category Receipts. 

Column Receipts 

Single-level price differences  

Multilevel price differences  

19. To display the origin of the multilevel price differences, choose Receipts → Stock transfer. 

20. Select Receipts from lower levels and using the right mouse button choose Display 
document.  

In the screen Display Material Ledger Document XXX: Overview you can see from which 
material the multilevel price difference comes. 

 
You may have to expand the list level if no material is displayed. Click on the 
appropriate file symbol. 

21. Choose , until the screen Costing Cockpit: Actual Costing – Change / Execute appears. 

22. Double-click on material ACT-DCD in plant 6000 and open the category Receipts. 

23. Check the price variances for the demo CD’s and note how high the price differences are. 

Column Price differences 

Receipt from purchase orders  

Receipt from production  

24. To analyze the price differences from the receipt of the production choose   → Select 
layout. 

25. In the dialog box Choose layout select the entry Single- and multilevel differences and 
choose Copy. 

26. Make a note of the amount of the differences in the row Production. 

Column Production 

Single-level price difference  

Multilevel price difference  

27. Using the material document, check which material components are responsible for the 
multilevel price differences.  
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28. In the category Production select the step Receipts from lower levels and using the right 
mouse button choose Display document. 

You can see from which material the multilevel price difference comes. 

 
You may have to expand the list level if no material is displayed. Click on the 
appropriate file symbol. 

29. Choose , until the screen Costing Cockpit: Actual Costing – Change / Execute appears. 

30. In the row Post closing double-click on . 

This allows you to carry out closing postings. 

31. In the row Post closing double-click on . 

32. In the screen Maintain Variant: Report SAPRCKMA_RUN_CLOSE, Variant enter the 
following data: 

Field Data 

Execute Select 
Revaluate material Select 
Background processing Deselect 
Test run Deselect 
Save log Select 

33. Choose . 

The system displays the message Values of variant XXX saved. 

34. Choose . 

35. In the row Post closing double-click on . 

The system displays the results log. The system displays which materials have been 
successfully closed. 

36. Choose  until the overview tree appears. 
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Analyzing the Multilevel Price Determination 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Actual 
Costing/Material Ledger → Material Ledger → Material Price Analysis 

Transaction Code CKM3 

2. Enter the following data: 

Field Data 

Material ACT-LCD 
Plant 6000 
Period/year Current period/current fiscal year 
Currency Company code currency 

3. Choose  Prices and inventory values. 

4. Open the category Consumption in the overview list, in order to display the process 
categories Production and Cost center 

5. Check the following entries for the period selected: 

Field Data 

Period status Closing posting carried out 

Standard price XXX 

Periodic unit price XXX 

Price control V 

Current stock value XXX 

Inv. value (stat.) XXX 

In the lower screen area: 

Cumulative inventory XXX 

Consumption XXX 

Production XXX 

Cost center XXX 

Ending inventory XXX 

 
Note that the price control for the closed posting period has changed. 

6. Choose  Closing document. 

7. In the screen Display Material Ledger Document XXX: Overview choose Accounting 
documents. 
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8. In the List of Documents in Accounting dialog box, choose the accounting document having 
the lowest document number. 

The system displays the posting record.Posting is carried out in the closing period. 

9. Choose  and display the second accounting document in the dialog box List of Documents 
in Accounting. 

You will see that the document posted in the previous period was cancelled with this 
document in the current period. 

10. Choose  until the overview tree appears. 

11. In the List of Documents in Accounting dialog box, choose . 
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Analyzing the Multilevel Price Determination 
Purpose 
Multilevel price determination is used to calculate the actual prices of externally procured and in-
house materials. The calculation of actual prices can be used to valuate the period-end inventory  
In addition, the Material Ledger/Actual Costing component provides you with numerous tools 
which you can use to analyze current prices. 

The following scenarios are envisaged for the Multilevel price determination: 

• Carrying out multilevel price determination and simple analysis 

• Analysis for a multilevel price determination with the actual cost component split and 
integration with Profitability Analysis 

In this demonstration you carry out the results analysis for multilevel price determination from the 
viewpoint of both a product manager and an inventory accountant. 

You can find more information about this process under  [Page 115]. 

Prerequisites 
To calculate the actual costs at the period end you must have set the material ledger in the 
relevant controlling area to active, and you must specify that the materials have to be included in 
the actual costing.  

Process Flow 
You can find the data for this process under  [Page 116]. 

1. Results Analysis from the Product Manager Viewpoint [Page 117] 

2. Results Analysis from the Inventory Accountant Viewpoint [Page 120] 
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Additional Process Information 
IDES Mexico produces and labels CD ROMS containing demonstration versions of your current 
software. The entire value chain from procurement to distribution is subject to an actual costing 
for which you use the material ledger and Profitability Analysis. 

In the following example the period result is considered from the viewpoint of a variety of user 
roles: 

• The product manager (SAP standard role: SAP_WP_SALES_BUSINESS_ANALYST) is 
interested in the sales and revenue figures and compares plan, target and actual costs with 
each other in a contribution margin scheme  

• The inventory accountant (SAP standard role: SAP_WP_INVENTORY_ACCOUNTANT ) is 
responsible for inventory quantities and inventory price history. Of particular interest is the 
process of calculating the actual prices across the entire process chain, including the prices 
allocated by the cost centers. 
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Data Used During This Process 
Field Data 

Operating concern IDEA 

Controlling area 6000 

Plant 6000 

6100 

Cost center group H64_530 

Material ACT-DCD 

ACT-BCD 

ACT-LCD 
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Results Analysis from the Product Manager Viewpoint 
Use 
With the revenue growth for the periods July and August not agreed, the area manager requests 
a detailed report from you in your capacity as product manager responsible for the CD’s. 

You compare the plan with the target and actual values. 

Procedure 
1. Call up the transaction as follows: 
Menu Path Accounting → Controlling → Profitability Analysis → Information System 

→ Execute Report 

Transaction Code KE30 

 
The first time you perform profitability analysis you are requested to enter an 
operating concern. 

2. In the Set Operating Concern dialog box, enter the following data: 

Field Data 

Operating concern IDEA 

Costing-based Select 

3. Choose . 
4. In the profitability analysis reporting tree, double-click on the report IDES 380 Actual Cost 

Component Split – CM. 
5. Enter the following data: 
Field Data 

From period/year 007.2000 

To period/year 007.2000 

6. Choose . 

The report displays a contribution margin scheme that is divided into the sections 
variable cost of goods manufactured (CM1), fixed cost of goods manufactured (CM2), 
and other costs (CM3). You can see the appropriate values for the planned sales 
quantity (Plan data column), the actual quantities valuated with the standard cost 
estimate and the actual quantity at actual prices. 

The costs for the material components are considerably higher than planned. 

7. To understand the reason for this variance, choose . 

8. In the dialog box Choose report, double-click on the report Material Price Analysis. 
9. Enter the following data: 
Field Data 

Material ACT-DCD 
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Plant 6000 

Period/year 007.2000 

Currency Company code currency 

View Price determination structure 

10. Choose . 

In the Material Price Analysis screen you will see that price differences have been posted 
for the material in the category Receipts. 

11. Open the category Receipts. 
You will notice that the price differences for the most part originate in the external 
procurement. 

12. Choose , until the screen Execute Profitability Report Actual Cost Component Split – CM 
is displayed 

You establish that the costs for salaries and wages are substantially higher than the 
target values.  

13. To understand this variance, choose . 
14. In the Choose report dialog box, double-click on the report Cost Centers: 

Actual/Plan/Variance). 
15. Enter the following data: 
Field Data 

Controlling area 6000 

Fiscal year 2000 

From Period 007 

To period 007 

Plan version 0 

Cost center group H64_530 

16. Choose . 
The plan and actual costs of the selected cost center group are displayed. 

17. To analyze the values of the individual cost centers, select the individual cost centers. 
You will see that the larger variances originate in the cost center Recording studio. 

 

To display or hide the navigation bar on the screen, choose  (Navigation on/off). 
 
18. Choose  until the overview tree appears. 
19. In the dialog box Exit reports choose Yes. 

Result 
You now know why contribution margin III for your product has turned out to be so low in 
comparison to the plan and target values, even though you have purchased more than planned: 
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the delivered prices of the raw materials are higher than you estimated, and in addition the labor 
costs in the recording studio are higher than planned. 
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Results Analysis from the Inventory Accountant 
Viewpoint 
Use 
As an inventory accountant you are concerned more with the inventory than revenue. You are, 
therefore interested in the result of the actual costing which provides you with amongst other 
things details about the material price history and the inventory value history. In addition to this, 
you can check if any incorrect entries have been made prior to a closing valuation. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost Controlling → Actual 
Costing/Material Ledger → Actual Costing → Edit Costing Run 

Transaction Code CKMLCP 

2. Enter the following data: 

Field Data 

Costing run CA 6000 

Period 007.2000 

3. Choose . 

4. Choose  General Data. 

You will see that the costing run for the plants in Mexico City and Monterrey have been 
created. 

5. Choose  Process. 

You will see in the Successful column in the line Post closing that the costing run for all 
four materials selected has been closed successfully. 

6. Choose  Costing results. 

You can understand the flow steps on the basis of the status messages. 

You can represent the results in various views and hierarchies and also display the 
material list with filters. 

7. To select the costing run, select the following entries in the area Costing results: 

Field Data 

View Overview: Costing Run 

Hierarchy CstngRun/plant/mat. type/val. class/origin group 

You will note that of the four materials selected, three come from plant 6000 in Mexico 
and one from plant 6100 in Monterrey.  

8. Expand the structure of plant 6000 in the column Results. 
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You will see that one finished product, one semi-finished product and one raw material 
have been selected in plant 6000. 

9. To determine the sequence of the costing run, select the following entries in the area Costing 
results: 

Field Data 

View Overview: Costing Run 

Hierarchy Costing run/level/cycle no. 

All of the materials selected for which no postings have been created in the period are 
assigned level 0. All of the materials selected which do not have multi-level receipts are 
assigned level 1. All other materials are assigned according to their level in the 
production process. 

In the selected setting you will see that of the four materials, two are assigned to level 1, 
one is assigned to level 2 and one to level 3. Postings are created for all materials which 
are intended for the actual costing (material price determination 3)   

Moreover, you will notice that two materials do not have multilevel receipts, meaning no 
multilevel price determination is necessary, recogizable by the minus sign in column P 
(multilevel price determination). 

10. To call up single-level price determination, select the following entries in the area Costing 
results: 

Field Data 

View Single-level price determination 

Hierarchy CstngRun/plant/mat. type/val. class/origin group 

Single-level price determination is carried out for all materials selected and is a 
prerequisite for both the mulitlevel price determination and the closing entries. 

You can see that single-level price determination has been carried out successfully 
(which you can recognize by the green traffic light or the green column). 

11. To call up multilevel price determination, select the following entries in the area Costing 
results: 

Field Data 

View Multilevel price determination 

Hierarchy Costing run/level/cycle no. 

You see that the multilevel price determination has been carried out successfully for the 
materials for levels 2 and 3. 

12. Change the hierarchy in the area Costing results as follows: 

Field Data 

View Multilevel price determination 

Hierarchy CstngRun/plant/mat. type/val. class/origin group 

You see that in both plants respectively one material has been costed multi-level. 

13. To check the closing entry, select the following entries in the area Costing results: 
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Field Data 

View Closing entry 

Hierarchy CstngRun/plant/mat. type/val. class/origin group 

You will see that the closing entry for all of the materials selected has been performed 
successfully. 

14. To display the results in detail, select the following entries in the area Costing results: 

Field Data 

View Overview: Costing Run 

Hierarchy CstngRun/plant/mat. type/val. class/origin group 

15. Select costing run CA 6000 and choose   → Display material list with filter → Materials 
with goods movements. 

You see a list of all the appropriate materials. This is a further detailed display of the 
results you have already analyzed. 

16. Choose   → Select layout. 

17. In the dialog box Layout choose choose Price analysis with material short text. 

You receive the variances from each material between the preliminary valuation price 
and the periodic unit price. The list is sorted according to the percentage variances. You 
can now see, at a glance, the materials for which you need to carry out a more detailed 
price analysis. 

The material with the greatest percentage variance is in this case the labels for the CD’s, 
so you must now carry out a detailed analysis. 

18. Double-click on the appropriate material. 

The Material price analysis screen appears.  

You will see in the Price column that the price of both the period beginning inventory and 
that of the receipts is higher than the planned price. 

19. Open the structure Receipts, then process category Purchase order and the procurement 
alternative Fabricas Mixtli. 

You will see that the goods receipt was posted without price differences and conclude 
that the price used in the purchase order was the preliminary valuation price.  

In addition you will notice that the price differences arise upon receipt of the invoice, 
meaning the vendor has entered a higher amount in the invoice than agreed in the 
purchase order. 

20. Choose  until the Material price analysis screen appears. 

The material with the second highest variances is the completed demo CD’s. 

21. To carry out a price analysis, double-click on this material.  

You will notice that the variances for the most part originate in the external procurement. 
However, since you are interested in a more detailed analysis, you also examine the 
causes of the variances for production.  
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22. Open the structure Receipts, then process category Production and the procurement 
alternative Production Version 1. 

You see three documents: 

• The goods receipt with which the finished article was posted from production to the 
warehouse. No price differences have arisen here as the material was valuated with 
the preliminary valuation price within the period. 

• The order settlement has produced a small price difference; you discuss this with the 
manager of the cost center responsible. 

• Multilevel price determination has generated the third document (receipts from lower 
levels) and displays a larger price difference.  

23. Double-click to select this document: 

You will see that the price determination has settled price differences for the material 
components, the cost centers and Activity-Based Costing to the demo CD’s. It is clear 
that the two items Blank CD (material component) and Recording CD (activity type) are 
responsible for the greater part of the price differences. 

For the manufacture of 800 demo CD’s, 900 blanks have been used. 

24. To display the material price analysis of the blank, double-click on material ACT_BCD. 

25. Open the structure Receipts, then the process category Purchase order. 

You will see that the cause of the price differences is the delivered price for purchase 
order with vendor Productos Argentinos. 

26. Choose , until you return to the document for multilevel price determination. 

To manufacture the 800 demo CD’s required a further 8.5 hours of activity type 
Recording CD. You recognise differences that have been allocated to the demo CD’s 
through the variances between the actual price and the plan price. 

27. Choose  until the overview tree appears. 

 

Result 
This leads you to conclude that the price of the demo CD’s is higher than planned due to 
higher costs for the blank CD’s and higher activity prices for recording them. 
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Easy Cost Planning and Execution Services for an IT 
Project 
Purpose 
You company wishes to implement new software. You are going to use the project system for 
this. Cost control is of prime importance. For simple and efficient cost planning you are using the 
Easy Cost Planning costing method. Your company has already implemented several projects of 
this kind, and consequently you are able to refer back to a standard project for the structure of 
the project and planning forms for the calculation of the costs. As the project progresses you use 
the Execution Services direct to cost various subsequent processes, such as purchase 
requisitions. 

You can find a description of how you create planning forms in the process Ad hoc cost estimate 
with Easy Cost Planning [Page 139]. 

You can find a detailed description of the costing methods Easy Cost Planning and Execution 
Services in the standard SAP documentation under Accounting → Controlling → Product Cost 
Controlling → Product Cost Planning.  

Easy Cost Planning and Execution Services [Ext.] 

Process Flow 
You can find the data for this process under  [Page 126] 

1. Using the Project Builder create the project with the template for the standard project I/0002. 
Because cost control is of prime importance in this procedure, you map your project via a 
work breakdown structure without activities. 

Creating a Project with Template [Page 127] 

2. You plan the costs of your project by using predefined planning forms. In the planning forms 
you specify the cost relevant factors (characteristics) and the conversion of these into the 
costing items of the unit costing. As planner you define the characteristics based on your 
project-specific data, for example number of licenses, and the system determines the 
quantities and prices of the costing items. This does not require a detailed knowledge of unit 
costing. 

Planning Costs using Easy Cost Planning [Page 130] 

3. As planning proceeds you receive additional information about the project and make the 
planning complete.  

Changing Cost Planning [Page 132] 

4. The planning is accepted and you release parts of the project for execution. 

Releasing the Project [Page 134] 

5. In the further course of the project you trigger various subsequent processes (such as 
internal activity allocation) directly from the planning function. 

Carrying out Execution Services [Page 135] 

6. To gain an overview of the cost process check the plan/actual position. 

Evaluating Costs in Reporting [Page 138] 
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Data Used During This Process 
Field Data Description 

Controlling Area 1000 CO Europe 

Company Code 1000 IDES AG 

Plant 1300 Frankfurt 

Standard Project I-0002 IT Project Nellos 

Planning Form ZPS000 Nellos 

Planning Form ZPS001 IT: Concept 

Planning Form ZPS002 IT: Implementation 

Planning Form ZPS003 IT: Team Preparation 

Planning Form ZPS004 IT: Prep. With External Consultants 
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Creating a Project with Template 
Use 
The organizational structure of the project results from the use of the work breakdown structure 
(WBS). You have already created a standard template during the initial system implementation 
phase, which you can use when you create the project using the Project Builder. The project is 
structured only by using WBS elements.  

The Project Builder offers you a simple introduction to using the Project System and integrates all 
of the specific functions required to process the project. Not only can you maintain all of the data 
for a project structure in the Project Builder, you can also carry out Easy Cost Planning and 
trigger the Execution Services. 

You can find a detailed description of the functions in the standard documentation for the Project 
System via Structures → Project Builder. 

Project Builder [Ext.] 

The following graphic shows you the structure of the project “Nellos”. The later cost planning is 
carried out for those WBS elements indicated as a planning element (P). 

Training

Test Pilot System

 P Team 
Preparation

 Confirm Module

 Order Management

P Detail Design and 
System Set up

P Concept and 
Organization

Order 
Management

Confirm Module
Implementation

System
Optimization

Nellos
System Implementation

Nellos

 

Prerequisites 
You have maintained the standard project I/0002 in your system. 

Procedure 
1. Call up the transaction as follows: 
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Menu path Accounting → Project System → Project → Project Builder 
Transaction code CJ20N 

On first accessing the Project Builder a dialog window appears giving you information 
about the subsequent user-specific settings that need to be made. 

2. To maintain user-specific settings, choose  in the dialog box. 

The dialog box Project Builder: User-specific options appears. Here you can specify both 
the general settings and also which project elements you will need as templates, for 
example Standard templates. 

 
You can change the user-defined settings at any time by choosing Settings → 
Options. 

3. If you want to preview the last project you edited in the screen area Structure tree, select 
Preview last project and choose .  

You access the Project Builder. The screen is divided into three areas: In the top left 
area you are given an overview of the structure of the project you have created (in the 
following structure tree). Beneath this is the worklist and template area. The actual work 
area is on the right side of the screen. 

4. Choose in the screen area Structure Tree  → Copy Project. 

5. Enter the following data: 

Field Data 

Project definition I/00XX 

(where XX stands for any two figure number) 

Project profile Cost projects 

Std. proj. def. I/0002 

6. Choose . 

The system creates the project and displays the structure in the screen area Structure 
tree. In the work area the system opens the detail screen for the project definition. 

7. Under Identification and view selection in the work area add the project number I/00XX to 
the entry Nellos system implementation. 

8. In the Basic data tab page, enter the following data: 

Field Data 

Start date (The current date) 

Finish date The current date + 3 Months 

9. In the structure tree click on the WBS element  Concept and Organization 

The system displays the detail screen in the work area. The WBS element is flagged as 
a planning element and an account assignment element (operative indicators). 

10. Choose  and select Yes for the warning message displayed. 
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Result 
The system creates the project. In the Project Builder you can find the project in the screen area 
Worklist under Last projects processed. In the following you plan the costs. 

Planning Costs using Easy Cost Planning [Page 130] 
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Planning Costs using Easy Cost Planning 
Use 
As project leader you decide to plan your costs using Easy Cost Planning. To make the work 
easier you include the relevant planning form in your worklist. You then assign the corresponding 
planning forms to the planning elements of your project and define the characteristics.  

Procedure 
1. Call up your project in the Project Builder by double-clicking on Project I/00XX displayed in 

the structure tree as a preview. 

2. Choose . 

A dialog box appears with the predefined costing variant PS06. 

3. Choose  Create Cost Estimate. 

The screen Easy Cost Planning appears. The costing structure and the worklist are 
displayed in the left hand side of the screen. The system has transferred the project 
structure to the costing structure. The planning elements are indicated by . 

The right-hand side of the screen is the work area. In the lower screen area you find the 
item overview.  

4. If the item overview is not displayed, choose Show/Hide Item View. 

5. If the worklist in the lower left screen area is not displayed, choose . 

Including Planning Forms in the Worklist 

1. In the screen area Worklists, choose  next to the directory My Planning Templates. 

2. Enter ZPS00* as a search term in the field Costing model. 

3. Choose . 

4. Select planning forms ZPS001 to ZPS003 and choose . 

The system transfers the planning forms to the screen area Worklists. If necessary 
change the width of the column to see the entire description. 

Assigning the Planning Forms to the Project Elements 

1. In the screen area Costing Structure select the WBS element   Concept and 
Organization. 

2. Click on the planning form IT:Concept in the screen area Worklists. 

The system displays the entry screen with the characteristics for the planning form in the 
work area.  

3. Enter the following data: 

Field Data 

Working Hours 100 
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Additional Costs 2000 

4. Choose Confirm. 

Depending on the data you entered the system determines the costing items using the 
planning form and displays them in the costing structure.  

5. If you would like an overview of the meaning of the symbol legends displayed in the costing 
structure, choose  in the application toolbar. 

6. Similarly, assign planning forms to the following WBS elements: 

WBS element Planning form 

Detailed Design and System Set Up IT: Implementation 

Team Preparation IT: Preparation 

7. Enter the following data: 

In the planning form entry screen Field Data 

IT: Implementation Internal Working Hours 130 

 Number of Licenses 50 

IT: Team preparation Internal Working Hours 90 

8. Choose Confirm. 

9. If you want to see the aggregate costs on the project, either change the column width as 
necessary in the screen area Costing structure, or increase the screen area. 

10. Choose . 

You access the Project Builder.  

11. Choose . 

Result 
You have planned the project costs. Once you have received detailed information about the 
project, change the cost planning. 

Changing Cost Planning [Page 132] 
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Changing Cost Planning 
Use 
You supplement the costing for the WBS element Detailed Design and System Set Up by two 
further costing items and change the values in the planning form entry screen IT: Team 
Preparation. 

Procedure 
1. Call up your project in the Project Builder by double-clicking on Project I/00XX displayed in 

the structure area as a preview. 

2. Choose . 

3. In the costing structure select the WBS element   Detailed Design and System Set Up. 

The system displays the entry screen of the assigned planning form in the work area. 

4. If the item overview is not displayed, choose Show/Hide Item View. 

5. To supplement the cost estimate choose  twice in the item overview. 

6. Enter the following data: 

Item cat. Resource Plant/Activity type Quantity 

E 4295 1463 10 

M B-1000 1000 10 

7. Choose Confirm. 

You have supplemented the cost estimate by one internal activity (manager hours) and 
one material item. 

8. In the costing structure select the WBS element   Team Preparation. 

9. Enter the following data: 

Field Data 

Internal Working Hours 120 

10. Choose Confirm. 

In the planning form you have a resource restriction of 100 hours of internal personnel 
time. Because you have scheduled more than 100 hours personnel time the system 
inserts an additional planning form in the costing structure. The items in planning form IT: 
Team preparation are removed from the costing structure.  

11. Navigate in the screen area Costing Structure to the end of the structure. 

12. Choose the IT:Prep. With Ext. Consultants node. 

In the work area the planning form entry screen is displayed. 

13. Enter the following data: 

Field Data 
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External Consultant Hours 50 

Internal Working Hours 70 

14. Choose Confirm. 

The system transfers the costing items just determined to the structure. 

15. Choose . 

You access the Project Builder.  

16. Choose . 

Result 
You have completed your planning and can release the project for implementation. 

Releasing the Project [Page 134] 
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Releasing the Project 
Use 
Before you can post actual costs to the WBS elements you have to set the system status 
Released. 

Procedure 
1. Call up your project in the Project Builder by double-clicking on Project I/00XX displayed in 

the structure area as a preview. 

2. Click on the project definition  in the screen area structure tree. 

3. Choose Edit → Status → Release. 

In the work area on the Basic Data tab page the system displays the system status REL 
Released. By releasing the project definition you also release all of the subordinate 
project elements. 

4. Choose . 

Result 
All project elements have been released and you can begin with the implementation of the 
project. You use the Execution Services for this purpose. 

Carrying out Execution Services [Page 135] 
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Carrying out Execution Services 
Use 
As the project progresses, you create actual costs for the costing items planned using Easy Cost 
Planning. 

To make your work easier you trigger the required follow-up actions for the cost estimate via 
Execution Services direct. The system automatically selects the appropriate costing items with 
the required data. You normally only need to confirm the posting. 

In this process you carry out the following Execution Services: 

• Activity allocation for the internal personnel hours worked 

• Goods issue for the office supplies taken from the warehouse 

• Purchase requisition for the software licenses 

Prerequisites 
You have carried out cost planning using Easy Cost Planning and released the project for the 
data to be posted. 

Procedure 
1. Call up your project in the Project Builder by double-clicking on Project I/00XX displayed in 

the structure area as a preview. 

2. Choose . 

The system displays the costing structure for the project. 

3. If the item overview is not displayed, choose Show/Hide Item View. 

4. Choose Show Execution Services. 

In the upper part of the screen you will see the checkbox Execution Service. 

Carrying out Internal Activity Allocation 

1. In the costing structure select the WBS element   Concept and Organization. 

The system displays the costing items. 

2. Select the Execution Service Internal Activity Allocation. 

The system selects all of the costing items of category E (internal activity) and P 
(process costs manually), and displays them in the item area.  

3. Choose . 

4. Choose Post.  

Posting Goods Issue 
1. Select the Execution Service Goods Issue. 

The system selects all costing items of category M (material items). 
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2. To supplement the posting data choose → Layout in the item overview. 

3. Select Layout 1SAP02 and then choose . 

4. Enter storage location 0001 for the item. 

5. Select the item and choose Post.  

Create Purchase Requisition 

1. In the costing structure select the WBS element   Concept and Organization. 

2. Select the Execution Service Purchase Requisition. 

The system selects all costing items of the following categories: 

− M (material) 

− F (external activity) 

− N (service) 

− V (variable items) 

− L (subcontracting) 

3. To supplement the posting data choose → Layout in the work area. 

4. Select Layout 1SAP05 Purchase Rquisition – Variable Item and then choose . 

5. For the item Additional Costs Concept enter the following data: 

Field Data 

Plant 1300 

Delivery date 14 days from today’s date 

Purchasing organization 1000 

Material group 014 

Purchasing group (PGr) 001 

6. Select this item and choose Post. 

The document is posted. 

7. To display the document overview, choose  in the upper right-hand of the work area. 

8. To refresh the display, choose  Refresh. 

The document for the purchase requisition is displayed. 

9. Choose , until the overview tree appears. 

You do not need to save again. The system has already posted the document. 

Result 
The activity allocation, the goods issue and the purchase requisition are posted and the actual 
costs or the commitment are updated on the project. Check the costs in reporting. 

Evaluating Costs in Reporting [Page 138] 
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Evaluating Costs in Reporting 
Use 
You check the posting by cost element of the costs in the information system.  

Procedure 
1. Call up the transaction as follows: 

Menu path From the Project System node, choose Information System → Financials 
→ Costs → Plan-Based → By Cost Element 
→ Actual/Commitment/Total/Plan in CO Area Currency 

Transaction code S_ALR_87013542 

2. Enter the DB profile 000000000001 if necessary.  

3. Enter the following data: 

Field Data 

Project I/00## 

Plan Version 0 

To Fiscal Year The Current Year + One Year 

4. Choose . 

In the report the aggregated plan costs and the commitments and actual costs arising 
from the Execution Services are displayed. 

5. In the structure tree click on the WBS element  Concept and Organization. 

6. In the report place the cursor on the column Actual and choose . 

You access the overview of the actual line items. 

7. To display the document, select it and choose . 

8. To leave the report keep choosing  and choose Yes each time in the dialog box. 
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Ad Hoc Cost Estimate using Easy Cost Planning 
Purpose 
For a quick cost simulation of frequently used planning objects you can use an ad hoc cost 
estimate.  This kind of cost estimate does not need a reference object. The basis of the cost 
estimate is the planning forms of Easy Cost Planning. You can create your own planning forms to 
suit your requirements. 

You can find a detailed description of Easy Cost Planning in the standard SAP documentation 
under Accounting → Controlling → Product Cost Controlling → Product Cost Planning. 

Easy Cost Planning and Execution Services [Ext.] 

In addition to ad hoc cost estimates, you can use Easy Cost Planning to plan the costs of the 
following objects: 

• Internal orders 

• Projects 

• Investment measures 

You can use the planning forms created in this process for the cost planning of these objects. 

See also: 
Easy Cost Planning and Execution Services for an IT Project [Page 124] 

Process Flow 
You can find the data for this process under  [Page 140] 

1. The costs are to be calculated for the initial work preparing your team of consultants. To do 
this, you in your capacity as the cost accountant create a suitable planning form. 

Create New Planning Form [Page 141] 

2. Because as yet no project, internal order or investment measure has been created in the 
system at the cost planning stage for the team preparation, you simulate the planned costs of 
your team of consultants in the ad hoc cost estimate. 

Creating Ad Hoc Cost Estimates [Page 145] 
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Data for this Example 
Field Data Description 

Controlling Area CO Europe 

1000 IDES AG 

Plant 1300 

Planning Form IT: With External Consultants 

1000 

Company Code 

Frankfurt 

ZPS004 
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Creating a New Planning Form 
Use 
To calculate the costs of getting your team ready for the job you create a planning form. Such 
costs depend on the planned consultant hours. To ensure you are adequately resourced, you 
specify that for more than 100 consultant hours external employees are to be used for the work. 
The additional costs incurred are also to be included in the cost estimate.  

You assign characteristics to the planning form. You specify in the derivation rules (template): 

• Which resources are to be included for the cost estimate 

• How the characteristics affect the resources required and their quantities 

• The conditions for including the items 

Procedure 
1. Call up the transaction as follows: 

Menu path Via the project system: 

Logistics → Project System → Basic Data → Templates → Models for 
Easy Cost Planning. 

Via Product Cost Planning: 

Accounting → Controlling → Product Cost Controlling → Product Cost 
Planning → Easy Cost Planning & Execution Services → Edit Ad Hoc Cost 
Estimate. 

Transaction code CKCM 

2. Enter controlling area 1000 as necessary and choose . 

The screen Easy Cost Planning: Model appears. The left-hand side contains the 
Worklists. The right-hand side of the screen is the work area for planning form 
maintenance. 

3. Choose  in the work area.  

The dialog box Create Model appears. 

4. Enter the following data: 

Field Data 
Costing Model ZXXX 

(where XXX stands for any three figure number) 
Name XXX IT: team preparation 

5. Choose .  

The system displays the various steps in model maintenance in the work area. You 
choose the process step Assign characteristics to the model. 

In the lower work area you will see the list for maintaining characteristics. 
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Assigning Characteristics 
1. Enter the following data: 

Field Data 
Characteristic Name PS_PERS_HOURS 

2. Choose . 

Because the characteristic has already been maintained, the system transfers the 
characteristic data. 

Creating Characteristics 
1. Enter the following data: 

Field Data 
Characteristic Name Z_XXX_Zusatz 

2. Choose . 

3. Choose Yes. 

Because the characteristic has not yet been maintained in the system, the characteristics 
maintenance screen appears. 

4. In the Basic data tab page, enter the following data: 

Field Data 
Description Additional costs (Euro) 

Format: 

Data Type 

 

Numeric format 

No of Chars 8 

Decimal places 2 

5. Choose . 

You return to the screen Easy Cost Planning: Model. 

Defining Derivation Rules 
1. Click on the node Define the derivation rules (template).  

The dialog box Selection of Reference Object appears. Select the reference object All 
objects. The planning form can be used for projects, internal orders, investment 
measures and ad hoc cost estimates. 

2. Choose .  

The Create Template screen appears.  

3. In the first row, enter the following data: 

Field Data 

Type Cost Center/Activity Type (use poss. entries) 
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Name Internal Consulting Hours 

Object Using possible entries: 

Cost Center: 4120 
Activity Type: 1412 
Name DV Service 

Select by double-clicking on the entry in the results list for the year 2000 

Quantity PS_PERS_HOURS 

4. In the second row enter the following data: 

Field Data 

Type Variable Item (use poss. entries) 

Name Additional Costs 

Object Using possible entries: 

Cost Element: 466000 

Quantity 1 

Activation Active (use poss. entries) 

Price Z_XXX_ZUSATZ 

5. In the third row, enter the following data: 

Field Data 

Type Costing Model (use poss. entries) 

Name IT: With External Consultants 

Object Using possible entries: 

Costing Model: ZPS004 

The variable costs are included in the cost estimate in every case. 

6. Choose . 

Setting Conditions 
1. Double-click on the Activation column in the row Internal consulting hours  

You access the method editor in which you specify the conditions for including an item in 
the cost estimate. 

2. Choose Insert condition. 

The Create Template Z_XXX. screen appears.  

3. Enter the following data: 

Field Data 

Comparison operand 1 PS_PERS_HOURS 

Comparison ≤ Less 
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Comparison operand 2 100  

4. Choose  Confirm. 

5. Choose .  

6. Double-click in the row IT: With External Consultants in the column Activation, and then 
choose Insert condition in the method editor. 

7. Enter the following data: 

Field Data 

Comparison operand 1 PS_PERS_HOURS 

Comparison > Greater 
Comparison operand 2 100  

8. Choose  Confirm.  

9. Choose .  

10. To save the derivation rules, choose . 

11. Choose .  

12. To save the planning form, choose . 
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Creating Ad Hoc Cost Estimates 
Use 
As the person responsible for costs you simulate the costs of preparing to use your team of 
consultants using the ad hoc cost estimate. For this you use the planning form ZXXX that you 
created in Controlling. 

Procedure 
1. Call up the transaction as follows: 

Menu Path Accounting → Controlling → Product Cost-Controlling → Product Cost 
Planning → Easy Cost Planning & Execution Services → Edit Ad hoc Cost 
Estimate 

Transaction Code CKECP 

2. Enter the controlling area 1000 if necessary. 

The screen Ad Hoc Cost Estimate appears. 

3. Enter a suitable text in the field Description. 

4. In the Create with planning form tab page, enter the following data: 

Field Data 

With Planning Forms ZXXX 
the 
plannin
g form 
that 
you 
created 

5. In the Additional data tab page, enter the following data: 

Field Data 

Costing Variant PADH 

Company Code 1000 

Plant 1300 

6. Choose Create. 

The screen Ad Hoc Cost Estimate: Change appears. On the left-hand side of the screen 
the costing structure is displayed, and on the right side the entry screen for the planning 
form. 

7. Enter the following data: 

Field Data 

Internal working hours 110 

Additional cost (Euro) 5000 
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8. Choose Confirm. 

Depending on the data you entered the system determines the costing items and inserts 
them in the costing structure.  

As you have planned more than 100 hours labor time, the system inserts the node 
ZPS004 IT: With External Consultants in the costing structure and not the internal activity 
item. You have not defined any conditions in the planning form for the variable costing 
item additional costs and the item is activated in each case. 

9. In the costing structure click on the planning form  With External Consultants. 
In the work area the system displays the entry screen for the planning form IT: With 
External Consultants. 

10. Enter the following data: 

Field Data 

External Consultant Hours 50 

Internal Working Hours 60 

11. Choose Confirm. 

The system determines the costing items and transfers these to the structure. 

12. If you would like an overview of the meaning of the symbol legends displayed in the costing 
structure, choose . 

13. If you want to see the total costs in the screen area Costing structure, either change the 
column width as appropriate or increase the screen area. 

14. To show the item overview in the lower half of the work area, choose Show/hide item view. 

15. Choose . 

The ad hoc cost estimate is saved. 
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